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Updated Information

This vCenter Converter Administration Guide is updated with each release of the product or when necessary.
This table provides the update history of the vCenter Converter Administration Guide.
Revision

Description

EN-000135-02

Minor revisions.

EN-000135-01

The topic “TCP/IP and UDP Port Requirements for Conversion,” on page 26 now
contains detailed TCP/IP and UDP port requirements for all conversion task types.

EN-000135-00

Initial release.
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About This Book

The vCenter Converter Administration Guide provides information about installing and using
®
VMware vCenter Converter for VMware vCenter Server 4.0.

Intended Audience
This guide is intended for users who want to do the following:
n

Install, upgrade, or use VMware vCenter Converter

n

Nonintrusively copy and transform physical machines into VMware virtual machines that vCenter Server
manages

The material in this book is written for information systems engineers, software developers, QA engineers,
trainers, salespeople who run demos, and anyone who wants to create virtual machines.

Document Feedback
VMware welcomes your suggestions for improving our documentation. If you have comments, send your
feedback to docfeedback@vmware.com.

Technical Support and Education Resources
The following technical support resources are available to you. To access the current version of this book and
other books, go to http://www.vmware.com/support/pubs.
Online and Telephone
Support

To use online support to submit technical support requests, view your product
and contract information, and register your products, go to
http://www.vmware.com/support.
Customers with appropriate support contracts should use telephone support
for the fastest response on priority 1 issues. Go to
http://www.vmware.com/support/phone_support.html.

Support Offerings

To find out how VMware support offerings can help meet your business needs,
go to http://www.vmware.com/support/services.

VMware Professional
Services

VMware Education Services courses offer extensive hands-on labs, case study
examples, and course materials designed to be used as on-the-job reference
tools. Courses are available onsite, in the classroom, and live online. For onsite
pilot programs and implementation best practices, VMware Consulting
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Services provides offerings to help you assess, plan, build, and manage your
virtual environment. To access information about education classes,
certification programs, and consulting services, go to
http://www.vmware.com/services.

8

VMware, Inc.

Introduction to VMware vCenter
Converter

1

®

VMware vCenter Converter is an optional module for VMware vCenter Server that you can use to import,
export, or reconfigure source physical machines, virtual machines, or system images to VMware virtual
machines.
This chapter includes the following topics:
n

“Migration with vCenter Converter,” on page 9

n

“VMware vCenter Converter Components,” on page 10

n

“Cloning and System Reconfiguration of Physical Machines,” on page 10

n

“Converting Existing Virtual Machines and System Images,” on page 15

n

“Restoring VCB Images,” on page 15

n

“Scheduling Recurring Tasks,” on page 16

n

“System Settings Affected by Conversion,” on page 18

n

“Changes to Virtual Hardware,” on page 18

n

“Collecting vCenter Converter Log Files,” on page 19

Migration with vCenter Converter
Migration with vCenter Converter involves cloning the source machine or image and exporting it to a
destination.
You can convert virtual machines that vCenter Server manages to different VMware virtual machine formats
and export those virtual machines for use with other VMware products. You can use vCenter Converter to
perform the following tasks:
n

Convert running remote physical machines to virtual machines and import the virtual machines to
ESX™/ ESXi or ESX/ESXi hosts that vCenter Server manages.

n

Convert and import virtual machines, such as VMware Workstation or Microsoft Virtual Server 2005 to
ESX/ESXi hosts that vCenter Server manages.

n

Convert third-party backup or disk images to ESX/ESXi hosts that vCenter Server manages.

n

Restore VMware Consolidated Backup images to ESX/ESXi hosts that vCenter Server manages.

n

Export virtual machines managed by vCenter Server hosts to other VMware virtual machine formats.

VMware, Inc.
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n

Reconfigure virtual machines managed by vCenter Server hosts so that they are bootable.

n

Customize virtual machines in the vCenter Server inventory (for example, change the host name or
network settings).

vCenter Converter does not support creating thin-provisioned target disks on ESX4.0/ESXi 4.0.

VMware vCenter Converter Components
Depending on the vCenter Converter component you install, you can perform hot or cold cloning, use a
command-line interface, or use the vCenter Converter Import, Export, or Reconfigure wizards from within the
VMware vSphere Client.
vCenter Converter includes the following components:
vCenter Converter
server

Enables the import and export of virtual machines using the vSphere Client or
the vCenter Converter CLI. Install the vCenter Converter server on
vCenter Server or on an independent machine with access to a vCenter Server.

vCenter Converter CLI

Provides a command-line interface to operate the vCenter Converter server.
You can install the vCenter Converter CLI on the same machine as a
vCenter Converter server or on another machine that has access to a
vCenter Converter server.

vCenter Converter agent

Prepares a physical machine for import from a remote machine running a
vCenter Converter server. The vCenter Converter server installs the agent on
physical machines only to import them as virtual machines. You can choose to
automatically remove the vCenter Converter agent from the physical machine
after the import is complete.

vCenter Converter client

The vCenter Converter server works with the vCenter Converter client. The
client component consists of the vCenter Converter client plug-in, which
provides access to the vCenter Converter Import, Export, and Reconfigure
wizards from within a vSphere Client.
After you install the vCenter Converter client plug-in from the vSphere Client
Plug-ins menu, the vCenter Converter Online Help is available from the
vSphere Client Help menu.

vCenter Converter Boot
CD

Enables cold cloning of physical machines.

Cloning and System Reconfiguration of Physical Machines
When you import a physical system, vCenter Converter uses cloning and system reconfiguration steps to create
and reconfigure the virtual machine, so that it works successfully in the vCenter Server environment. Because
the migration process is nondestructive, you can continue to use the original source machine after the import
completes.
Cloning is the process of creating a cloned disk, where the cloned disk is a virtual disk that is an exact copy of
the source physical disk. Cloning involves copying the data on the source machine’s hard disk and transferring
that data to a target virtual disk.
System reconfiguration adjusts the migrated operating system to enable it to function on virtual hardware.
This adjustment is performed on the cloned disk and enables the cloned disk to function as a bootable system
disk in a virtual machine.
If you plan to run an imported virtual machine on the same network as the source physical machine, you must
modify the network name and IP address on one of the machines, so that the physical and virtual machines
can coexist.
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Hot and Cold Cloning
vCenter Converter supports hot cloning and cold cloning. Hot cloning, also called live cloning or online cloning,
clones the source machine while the operating system is running. Cold cloning, also called offline cloning,
clones the source machine when the operating system is not running.
When you cold clone a machine, you reboot the source machine using a CD that has the operating system and
vCenter Converter application on it. Cold cloning does not leave any software on the source machine.
When you hot clone dual-boot systems, you can clone only the default operating system to which the boot.ini
file points. To clone the nondefault operating system, change boot.ini to point to that operating system, then
reboot it. After you are booted in, you can use vCenter Converter to hot clone the nondefault system.
When you clone remotely, you can access the source machine remotely, as long as it is running and accessible
to the network. With local cloning, vCenter Converter runs on the source machine to perform the migration.

Remote Hot Cloning of a Physical Machine
You use the vCenter Converter wizard to set up a migration task, then vCenter Converter performs the cloning
tasks. During remote hot cloning, the machine you are cloning experiences no downtime.
The following workflow is an example of remote hot cloning, during which the physical machine being cloned
experiences no downtime.
1

The vCenter Converter server installs the vCenter Converter agent on the source machine.
The agent takes a snapshot of the source volumes.
vSphere Client with
vCenter Converter Client Plug-in

running
physical machine

agent

source
volumes

network
vCenter Server
with
vCenter Converter
Server

ESX/ESXi host
snapshot

source
2

VMware, Inc.

destination

vCenter Converter prepares the virtual machine on the destination machine.
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The server creates a new virtual machine on the destination machine and the agent copies volumes from
the source machine to the destination machine.
vSphere Client with
vCenter Converter Client Plug-in

running
physical machine

network
vCenter Server
with
vCenter Converter
Server

agent

source
volumes

snapshot
VM

ESX/ESXi host

volumes

destination

source
3

vCenter Converter completes the conversion process.
The agent installs the required drivers to allow the operating system to boot in a virtual machine and the
agent customizes the virtual machine (for example, changing the IP information).
vSphere Client with
vCenter Converter Client Plug-in

running
physical machine

agent

source
volumes

source

12

network

reco

nfigu

snapshot

vCenter Server
with
vCenter Converter
Server

ratio

n
custo

miza

tion (

opt.)

VM

ESX/ESXi host

destination

VMware, Inc.

Chapter 1 Introduction to VMware vCenter Converter

4

The vCenter Converter server removes all traces of the agent from the source machine.
vSphere Client with
vCenter Converter Client Plug-in

running
physical machine

network
vCenter Server
with
vCenter Converter
Server

source
volumes
VM

ESX/ESXi host

destination

source
The virtual machine is ready to run on the destination machine.

Local Cold Cloning Workflow of a Physical Machine
When you cold clone a machine, you reboot the source machine from a CD that has its own operating system
and also includes the vCenter Converter application.
The following workflow is an example of cold cloning the source machine when the operating system is not
running. You set up a migration task by using the Converter wizard on the boot CD.
1

vCenter Converter prepares the source machine image.
After you boot the source machine from the VMware vCenter Converter Boot CD and use
vCenter Converter to define and start the migration, vCenter Converter copies the source volumes into a
RAM disk.
network

physical machine

ESX/ESXi host managed
by vCenter Server

vCenter Converter
Boot CD
Converter
source
volumes

image in
RAM disk
copy

source
2
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vCenter Converter Standalone prepares the virtual machine on the destination machine.
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vCenter Converter creates a new virtual machine on the destination machine and copies volumes from
the source machine to the destination machine.
network

physical machine

ESX/ESXi host managed
by vCenter Server

vCenter Converter
Boot CD

VM

Converter
source
volumes

volumes

image in
RAM disk

source
3

destination

vCenter Converter completes the conversion process.
vCenter Converter installs the required drivers to allow the operating system to boot in a virtual machine
and personalizes the virtual machine (for example, changing the IP information).
network

physical machine

ESX/ESXi host managed
by vCenter Server

vCenter Converter
Boot CD
n
reconfiguratio
(opt.)
customization
Converter
source
volumes

image in
RAM disk

source
4

VM

destination

vCenter Converter leaves the source physical machine in its original state.
Remove the boot CD and reboot the source physical machine to return to its own operating system.

physical machine

network

ESX/ESXi host managed
by vCenter Server

vCenter Converter
Boot CD

VM

source
volumes

source

destination

The virtual machine is ready to run on the destination machine.
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Cloning Modes
vCenter Converter supports two cloning modes, disk-based cloning and volume-based cloning.

Disk-Based Cloning
vCenter Converter supports disk-based cloning for cold cloning and for importing existing virtual machines.
Disk-based cloning transfers all sectors from all disks, and preserves all volume metadata. The destination
virtual machine receives the same volumes of the same type as the volumes of the source virtual machine.
Disk-based cloning supports all basic and dynamic disks.

Volume-Based Cloning
vCenter Converter supports volume-based cloning for hot and cold cloning and for importing existing virtual
machines. In volume-based cloning, all volumes in the destination virtual machine are basic volumes,
regardless of the type in the corresponding source volume. Volume-based cloning is performed at the file level
or block level, depending on your size selections:
n

Volume-based cloning at the file level is performed when you select a size smaller than the original volume.

n

Volume-based cloning at the block level is performed when you select the same or a larger volume size.

Depending on the cloning mode, some types of source volumes might not be supported.
n

Cold cloning with the vCenter Converter Boot CD supports all types of dynamic volumes and Windows
NT 4 with mirrored volumes. Windows NT 4 fault-tolerant volumes are not supported.

n

Virtual machine importing supports basic volumes and all types of dynamic volumes, except RAID. It
does not support Windows NT 4 fault-tolerant volumes. It does support Windows NT 4 with mirrored
volumes. Only master boot record (MBR) disks are supported. GUID partition table (GPT) disks are not
supported.

n

Hot cloning supports all types of source volumes that Windows recognizes.

Converting Existing Virtual Machines and System Images
vCenter Converter creates a VMware virtual machine based on the source virtual machine or system image.
You can migrate VMware virtual machines between VMware Workstation, VMware Fusion™,
VMware Player, VMware ACE, VMware ESX/ESXi, and VMware Server. You can also import virtual machines
from Microsoft Virtual Server and Virtual PC.
To run an imported VMware virtual machine on the same network as the source virtual machine, you must
modify the network name and IP address on one of the virtual machines so that the original and new virtual
machines can coexist.
If the VMware virtual machines have disks that are populated using a backup of a physical host or some other
direct means of copying, vCenter Converter prepares the image to run on VMware virtual hardware.
Whenever you use one of the vCenter Converter wizards to import, export, or reconfigure a virtual machine,
you create a task. You can manage and schedule tasks.
You cannot schedule reconfiguration tasks.

Restoring VCB Images
VCB enables you to back up entire ESX/ESXi virtual machines and store the backup by using Workstation
disks, a .vmx file, and a catalog file. vCenter Converter can restore VCB images of any guest operating system
type on an ESX/ESXi host that vCenter Server manages.
For supported operating systems, you can select and resize volumes and customize the identity of the restored
virtual machine. For all other guest operating systems, vCenter Converter supports restoring only the disks.

VMware, Inc.
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vCenter Converter does not maintain the .nvram file or the VMware log files. Only disks are preserved.
vCenter Converter does not read the original location settings and display name from the catalog file. To restore
to the same location, you must look up information such as datastore, host name, folder name, and resource
pool in the catalog file and enter it in the Import wizard. In addition, vCenter Converter does not read the
original display name from the catalog file. If you want to use the same name and do not remember it, you can
look it up in the catalog file. You can read the catalog file as a plain text file.

Information Not Preserved When Importing VCB Images
When vCenter Converter restores VCB images, it does not preserve certain hardware backup information from
the original image, but rather substitutes default settings.
Table 1-1 shows the hardware information that is not preserved.
Table 1-1. Hardware Backup Information Not Preserved During VCB Restoration
Device

Behavior

CDROM

Defaults to device type: host device.

Floppy

Defaults to device type: host device.

Network adapters

Defaults to the list of network adapters in the GUI. The MAC address is not preserved. It is
regenerated by the destination host.

Serial port

Defaults to the physical serial port on the destination host machine.

Parallel port

Defaults to the physical parallel port on the destination host machine.

When vCenter Converter restores VCB images, it does not preserve certain other virtual machine properties
from the original image. Table 1-2 shows the areas that are affected.
Table 1-2. Virtual Machine Properties Not Preserved During VCB Restoration
Hardware setting

Behavior

UUID

The BIOS and location of the virtual machine, identified by uuid.bios and
uuid.location, are not preserved, but are regenerated by the host machine.

Disk resource allocation

Defaults to the values available on the host when the virtual machine is created.

Scheduling Recurring Tasks
You can schedule an unlimited number of physical-to-virtual recurring tasks and specify how the existing
virtual machines are to be retained.
You can create a virtual machine that is a periodic backup of a physical system, which streamlines the backup
process. Instead of restoring the backup image to the original system before you can recover it, you can
immediately recover the image by powering on the backup virtual machine.
For recurring tasks, the vCenter Converter agent must be installed permanently on the source machine. You
can select the frequency at which to run the task and how many virtual machines to keep.

Keeping an Unlimited Number of Virtual Machines
Recurring cloning tasks produce multiple copies of the same source system. vCenter Converter manages these
copies for optimal usage.
The vCenter Converter naming schema enables you to identify the most recent virtual machine and the order
in which the virtual machines were created. Virtual machines are time and date stamped to prevent overwriting
of existing machines. This approach requires additional disk space but guarantees that you always have a valid
backup.
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Handling Multiple Resultant Virtual Machines
You can keep multiple virtual machines as backups to an existing machine. vCenter Converter manages those
machines to prevent overwriting.
To keep a limited number of virtual machines as backups to an existing machine, enter a number on the
Schedule Task page of the Import or Export wizard. To prevent overwriting of existing virtual machines,
vCenter Converter verifies that the managed or hosted target virtual machine does not exist, and time and date
stamps are applied to the existing virtual machines.
vCenter Converter generates sequential virtual machine names and deletes old names.
In the managed environment, the virtual machine name is the unique identifier of the virtual machine and no
additional steps are required.
In the hosted environment, a directory is created for each virtual machine. The name of the directory must
match the virtual machine name.
If the existing target virtual machine cannot be renamed, for example if it is running, the clone stops and the
temporary virtual machine is removed to save disk space.
When you schedule an import or export to run at a specific time, you must set a retention policy. If the retention
policy is set to keep a specific number or an unlimited number of multiple virtual machines, the target virtual
machine name is used as a template. The new virtual machine names have time stamps attached to them.
Virtual machine names have an 80-character limit. However, VMware recommends a maximum of
60 characters because the time stamp might make the name exceed the limit.

Retention Policy for Virtual Machine Backup Images
You can keep an unlimited number of cloned virtual machines. For example, if disk space is not an issue, you
might prefer to keep all backup virtual machines, especially if backups are scheduled to run infrequently, such
as once a month.
You can set one of the following conditions for a retention policy:
n

Overwrite one virtual machine each time you run a task.

n

Create a virtual machine with each run and enter the number of previous images to keep.

n

Create a virtual machine with each run and keep all images.

Available choices depend on the frequency you choose to run the task. For example, if you choose to run a task
only once, you can choose to overwrite the target virtual machine.
If you schedule to overwrite one target virtual machine each time a conversion task is run, the following action
is taken:
n

After cloning succeeds, the old virtual machine is renamed to a unique name.

n

The new virtual machine is renamed to the target name.

n

The old virtual machine is deleted.

VMware, Inc.

17

vCenter Converter Administration Guide

System Settings Affected by Conversion
A VMware virtual machine that vCenter Converter creates contains an exact copy of the disk state of the source
physical machine, virtual machine, or system image. Some hardware-dependent drivers and sometimes the
mapped drive letters are exceptions to this behavior.
The following source computer settings remain identical:
n

Operating system configuration (computer name, security ID, user accounts, profiles and preferences, and
so on)

n

Applications and data files

n

Volume serial number for each disk partition

Because the target and the source virtual machines or system images have the same identities (name, SID, and
so on), running them on the same network can result in conflicts. To redeploy the source virtual machine or
system image, make sure that you do not run the source and target images or virtual machines on the same
network at the same time.
For example, if you use vCenter Converter to test whether you can run a Virtual PC virtual machine as a
VMware virtual machine without first decommissioning the original Virtual PC machine, you must first resolve
the duplicate ID problem. You can resolve this problem by customizing the virtual machines in the Import,
Export, or Reconfigure wizards.

Changes to Virtual Hardware
Most applications function correctly on the VMware virtual machine because their configuration and data files
have the same location as on the source virtual machine. However, applications might not work if they depend
on specific characteristics of the underlying hardware, such as the serial number or the device manufacturer.
When you troubleshoot a virtual machine after it is migrated, notice the potential hardware changes in
Table 1-3.
Table 1-3. Hardware Changes After Virtual Machine Migration

18

Hardware

Behavior

CPU model and serial numbers

Can be different if they are activated. They correspond to the physical computer
hosting the VMware virtual machine.

Ethernet adapters

Can be different (AMD PCNet or VMXnet) with a different MAC address. The
IP address of each interface must be individually reconfigured.

Graphics cards

Can be different (VMware SVGA card).

Disks and partitions

The number of disks and partitions are the same, but each disk device can have a
different model and different manufacturer strings.

Primary disk controllers

Can be different from the source machine.

Applications

Might not work if they depend on devices that are not available within a virtual
machine.

VMware, Inc.
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Collecting vCenter Converter Log Files
The vCenter Converter log files contain information about activities in your vCenter Converter environment.
VMware technical support might request these files to help resolve any problems you might have with
vCenter Converter.
The Log Info button on each page of the wizard extends the page to show the location of the temporary log
files. Retrieve the log files as soon as needed.
For information about collecting log information for other components in the vSphere environment, see the
vSphere 4.0 documentation.

VMware, Inc.
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2

This information describes the requirements for using vCenter Converter and the vCenter Converter client. It
also describes the compatibilities and interoperabilities among the systems on which the vCenter Converter
components work.
This chapter includes the following topics:
n

“Operating System Compatibility and Installation File Size Requirements,” on page 21

n

“Common Requirements for Remote Hot Cloning for Windows Operating Systems,” on page 23

n

“Supported Sources for Importing,” on page 24

n

“Supported Destinations for Exporting,” on page 26

n

“TCP/IP and UDP Port Requirements for Conversion,” on page 26

Operating System Compatibility and Installation File Size Requirements
vCenter Converter supports installation on a variety of platforms. The installation space requirements differ,
depending on the vCenter Converter components that you install.
vCenter Converter requires a connection to vCenter Server 4.0. Each vCenter Converter server that is installed
as part of vCenter Converter must be associated with only one vCenter Server.
You can install vCenter Converter on the same computer as vCenter Server or on another computer that has
access to a vCenter Server.
You can install vCenter Converter on the following Microsoft Windows operating systems:
n

Windows Server 2000 SP4 with Update Rollup 1

n

Windows Server 2003 SP2 (32 bit and 64 bit)

n

Windows Server 2003 R2 SP2 (32 bit and 64 bit)

n

Windows Server 2008 (32 bit and 64 bit)

n

Windows Vista SP1 (32 bit and 64 bit)

n

Windows XP Professional SP3 (32 bit and 64 bit)

You can install the vCenter Converter CLI on Linux computers.

Installation Space Requirements
During installation you can choose which vCenter Converter components to install. Individual components
have different disk space requirements for installation.
Table 2-1 lists the disk space requirements for installation of vCenter Converter and its components.

VMware, Inc.
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Table 2-1. Installation Space Requirements
Installation Component

Size

Installer

43MB

vCenter Converter server files

74MB

vCenter Converter CLI files

36MB

vCenter Converter agent files

37MB

Supported Operating Systems
The operating system on which you install vCenter Converter server determines which virtual machines and
third-party images you can import, export, and reconfigure.
Table 2-2 displays operating system compatibility information.
Table 2-2. Operating System Compatibility for Importing, Exporting, and Reconfiguring Virtual Machines and
Third-Party Images
Operating System
on Which vCenter
Converter Server Is
Installed

Compatible Source Virtual Machine or Third-Party Image Operating Systems
Windows
NT

Windows
2000

Windows 2000

X

X

Windows XP

X

Windows 2003

Windows XP

Windows
2003

Windows
Vista

Windows 2008

X

X

X

X

X

X

X

X

X

X

X

Windows Vista

X

X

X

X

X

X

Windows 2008

X

X

X

X

X

X

vCenter Converter Client Requirements
The vCenter Converter client is installed as a plug-in for vSphere Client. You access the Import, Export, and
Reconfigure wizards from the client to set up your migrations.
You can install the vCenter Converter client on the following Microsoft Windows operating systems.
n

Windows 2000 Pro SP4

n

Windows Server 2000 SP4 with Update Rollup 1

n

Windows Server 2003 SP2

n

Windows Server 2003 R2 SP2

n

Windows Server 2008

n

Windows Vista Business

n

Windows Vista Enterprise

n

Windows XP Professional SP3

Table 2-3 lists the space required for the client installation.
Table 2-3. Space Requirements for VMware Converter Client Installation

22

Installation Component

Size

Installer

21MB

vCenter Converter client files

48MB
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Memory Requirements for Hot and Cold Cloning
Memory requirements differ, depending on the type of cloning you are performing.
For hot cloning, vCenter Converter requires 350MB of free space on the source physical machine.
For cold cloning with the VMware vCenter Converter Boot CD, the source physical machine must also meet
the memory requirements as listed in Table 2-4.
To run the VMware vCenter Converter Boot CD requires 264MB of memory on the source physical machine.
The recommended memory is 364MB.
Table 2-4. Memory Requirements for Cold Cloning with the Boot CD
Source Physical Machine Memory

Boot CD Cold Clone Capability

Less than 264MB

Cannot perform a cold clone.

Greater than or equal to 264MB but less than 296MB

Can perform a cold clone, but cannot use a RAM disk.

Greater than or equal to 296MB but less than 364MB

Can perform a cold clone with a RAM disk, although using a
network share is suggested. The RAM disk size is
m minus 264MB

Greater than or equal to 364MB

Can perform a cold clone with a RAM disk. The RAM disk size
is
m minus 264MB
up to a limit of 124MB.

Common Requirements for Remote Hot Cloning for Windows Operating
Systems
To help you avoid problems related to permissions and network access, ensure that Simple File Sharing is
turned off and that File and Printer Sharing is not blocked by Windows Firewall. Also, to access File and Printer
Sharing ports, you might need to change the scope of the IP addresses that the firewall allows.
You must allow incoming file share connections in the following cases:
n

When you use the machine to host standalone images

n

When you use the machine as a standalone destination

n

When you remotely hot clone the machine

Ensure that File and Printer Sharing Is Not Blocked by Windows Firewall
If vCenter Converter fails to connect to a remote Windows XP machine and issues a bad username/password
error message, ensure that file and printer sharing is not blocked by Windows Firewall.
Procedure
1

Select Start > Settings > Control Panel > Windows Firewall.

2

Click the Exceptions tab and ensure that File and Printer Sharing is selected.

3

If a third-party firewall is used, allow access to TCP ports 139 and 445, and to UDP ports 137 and 138.

What to do next
For troubleshooting information about File and Printer Sharing, search the Microsoft TechNet Web site.
For information about setting File and Printer Sharing on other Windows systems, see the documentation for
your system.
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Turn Off Simple File Sharing on Windows XP Professional
To control permissions for individual users, you must turn off Simple File Sharing.
Turning off Simple File Sharing does not turn off the Shared Documents feature. Use the Simple File Sharing
interface, located in the folder’s properties, to configure share and file permissions.
For Windows XP Professional operating systems joined to a workgroup, the Simple File Sharing UI is turned
on by default. Windows XP Professional operating systems joined to a domain use only the classic file sharing
and security interface.
Procedure
1

Select Start > Settings > Control Panel > Folder Options.

2

Click the View tab and select Use Simple File Sharing (Recommended).

What to do next
For additional information about turning Simple File Sharing on or off, see the Microsoft TechNet Web site.

Supported Sources for Importing
vCenter Converter can import physical machines, virtual machines, and system images into virtual machines
that vCenter Server manages.

Supported Physical Machines for Importing
The physical machine you import must have an operating system that vCenter Converter supports.
vCenter Converter can import any physical machine that is running one of the following operating systems:
n

Windows NT 4 Workstation/Server SP4+ (cold cloning only)

n

Windows 2000 Professional/Server/Advanced

n

Windows XP Home (cold cloning only)

n

Windows XP Professional (32 bit and 64 bit)

n

Windows Server 2003 Standard/Web/Enterprise (32 bit and 64 bit)

n

Windows Vista (32 bit and 64 bit)

n

Windows Server 2008 (32 and 64 bit)

Windows NT 4 Workstation/Server SP4+ is supported for cold cloning with the vCenter Converter Boot CD
only.

Supported Virtual Machines for Importing
vCenter Converter can import VMware and Windows virtual machines.
vCenter Converter can import virtual machines created with the following products and system images:
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n

ESX 4.0/ESXi 4.0, ESX 3.x/ESXi 3.x

n

ESX 4.0/ESXi 4.0, ESX 3.x/ESXi 3.x, and ESX Server 2.5 that vCenter Server 4.0 manages

n

ESX 3.x/ESXi 3.x, and ESX Server 2.5 that VirtualCenter 2.x manages

n

VMware Workstation 4.5.x, 5.x, 6.x

n

VMware Player 1.x, 2.x

n

VMware Server 1.0, 2.0
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n

VMware ACE 1.x, 2.x

n

VMware Fusion 1.x

n

Microsoft Virtual PC 2004 and later

n

Virtual Server 2005 R2 and later (.vmc)

n

Windows Server 2008 Hyper-V (must import as a physical computer)

Supported Virtual Machine Requirements
Before you begin a virtual machine import, note the requirements for the machine type you are importing.
Importing virtual machines has the following requirements.
n

Virtual machines must be powered off before you import them. You cannot import suspended virtual
machines.

n

Virtual machines from Macintosh versions of Virtual PC are not supported.

n

You can import hosted virtual machines (Workstation, Player, VMware Server, VMware ACE, Fusion)
and system images only if they reside on an accessible network mounted share.

n

The operating system on Virtual PC or Virtual Server virtual machines must be a Windows guest operating
system supported by vCenter Server 4.0. For a list of supported operating systems, see the
Guest Operating System Installation Guide.
vCenter Converter supports Virtual PC and Virtual Server virtual machines for cloning only with most
Windows operating systems preceding Windows NT 4.0. It does not support configuring for machines
with earlier Windows operating systems.

n

Virtual PC and Virtual Server virtual machines with guest operating systems other than Windows (for
example, Linux and DOS) are not compatible with vCenter Converter. This is true even when
vCenter Server 4.0 otherwise supports the guest operating system.

n

To import Virtual PC images, the Windows system on which you install vCenter Converter must have
Microsoft XML Core Services (MSXML) 2.6, 3, or 4 installed.

Supported System Images for Importing
vCenter Converter supports importing system images from Norton Ghost, Symantec LiveState,
Symantec Backup Exec System Recovery, StorageCraft ShadowProtect, Acronis True Image, and VCB.
Before you being the import process, note the limitations for Shadow Protect and
Symantec Backup Exec System Recovery images.
vCenter Converter can import system images from the following sources:
n

Norton Ghost 9.0, 10.0, 12.0

n

Symantec LiveState 3.0, 6.0

n

Symantec Backup Exec System Recovery 6.5, 7.0 (.sv2i)

n

StorageCraft ShadowProtect (.spf)

n

Acronis True Image 9, 10 (.tib)

n

VCB full backup images
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vCenter Converter can convert ShadowProtect and Symantec Backup Exec System Recovery images, with the
following limitations:
n

Dynamic disks are not supported.

n

All images for the backup of a machine must be in a single folder, with no other images placed in the
folder.

n

For volume-based cloning, you must back up all volumes on the disk up to the active and system volumes.
For example, if a disk has four partitions, 1 through 4, with partition 2 as the active volume and partition 3
as the system volume, the backup must include 1 through 3.

n

If the image is incremental, up to 16 incremental backups are supported.

n

Images of systems with logical drives are not supported if the logical drive is also a system or active volume
(ShadowProtect only).

Supported Destinations for Exporting
With vCenter Converter, you can export virtual machines that vCenter Server manages to other hosted or
managed VMware machines.
vCenter Converter can export virtual machines that vCenter Server manages to the following destinations:
n

ESX 4.0/ESXi 4.0, ESX 3.x/ESXi 3.x

n

ESX 4.0/ESXi 4.0, ESX 3.x/ESXi 3.x, and ESX Server 2.5 that vCenter Server 4.0 manages

n

ESX 3.x/ESXi 3.x, and ESX Server 2.5 that VirtualCenter 2.x manages

n

Vmware ESX Server 2.5 and ESX Server 2.5 that VirtualCenter 2.x manages

n

VMware Workstation 4.5.x, 5.x, 6.x

n

VMware Player 1.x, 2.x

n

VMware Server 1.0

n

VMware ACE 1.x, 2.x

n

VMware Fusion 1.x

You must export hosted virtual machines (Workstation, Player, VMware Server, VMware ACE, and
VMware Fusion) to an accessible network mounted share.

TCP/IP and UDP Port Requirements for Conversion
To enable conversion, the vCenter Converter server and client must be able to send data to each other, to remote
physical machines, or to vCenter Server. Also, the source and target hosts must receive data from each other.
Designated ports are reserved for this communication.
If any of these ports is blocked, the corresponding conversion task fails.

Ports Used when Importing a Powered-On Physical Machine Running Windows
The ports that must be open during the import of physical machine sources running Windows are listed in
Table 2-5.
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Table 2-5. Ports Required During Windows P2V
Communication Paths

Communication
Ports

Notes

vCenter Converter server to
powered-on source machine

TCP - 445, 139,
9089
UDP - 137, 138

If the source computer uses NetBIOS, port 445 is not required. If
NetBIOS is not being used, ports 137, 138, and 139 are not
required. If in doubt, make sure that none of the ports are
blocked.
NOTE Unless you have installed vCenter Converter server or
agent on the source computer, the account used for
authentication to the source computer must have a password,
network file sharing must be enabled on the source computer,
and Simple File Sharing must not be used.

vCenter Converter server to
vCenter Server

TCP - 443

Required only if the conversion destination is a vCenter Server.

vCenter Converter client to
vCenter Server

TCP - 443

Required only if a custom installation was performed and the
vCenter Converter server and client components are on different
machines.

Powered-on source machine to ESX/
ESXi

TCP - 443, 902

If the conversion destination is vCenter Server, only port 902 is
required.

Ports Used when Importing a Powered-On Physical Machine Running Linux
The ports that must be open during the import of physical machine sources running Linux are listed in
Table 2-6.
Table 2-6. Ports Required During Linux P2V
Communication Paths

TCP Ports

Notes

vCenter Converter server to powered-on
source machine
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Used to establish an SSH connection between the
vCenter Converter and the source machine.

vCenter Converter client to
vCenter Converter server

443

Required only if a custom installation was performed and the
vCenter Converter server and client components are on different
machines.

vCenter Converter server to
vCenter Server

443

Required only if the conversion destination is a vCenter Server.

vCenter Converter server to ESX/ESXi

443, 902,
903

If the conversion destination is a vCenter Server, only ports 902
and 903 are required.

vCenter Converter server to helper
virtual machine

443

Helper virtual machine to powered-on
source machine

22

Used to establish an SSH connection between the helper virtual
machine and the source machine. By default, the IP address of the
helper virtual machine is assigned by DHCP. If there is no DHCP
server available on the destination network, you must manually
assign the target virtual machine an IP address.

Ports Used when Importing or Exporting Virtual Machine Sources
The ports that must be open during the import and export of virtual machines are listed in Table 2-7.
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Table 2-7. Ports Required During V2V
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Communication Paths

Communication
Ports

vCenter Converter server to Fileshare
path

TCP - 445, 139
UPD - 137, 138

Required only for standalone virtual machine sources or
destinations. If the computer hosting the source or destination
path uses NetBIOS, port 445 is not required. If NetBIOS is not
being used, ports 137, 138, and 139 are not required. If in
doubt, make sure that none of the ports are blocked.

vCenter Converter client to
vCenter Converter server

TCP - 443

Required only if a custom installation was performed and the
vCenter Converter server and client components are on
different machines.

vCenter Converter server to
vCenter Server

TCP - 443

Required only if the conversion destination is a
vCenter Server.

vCenter Converter server to ESX/ESXi

TCP - 443, 902

If the conversion destination is a vCenter Server, only port 902
is required.

Notes
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3

This information describes the basic steps for installing and uninstalling vCenter Converter and the
vCenter Converter client.
This chapter includes the following topics:
n

“Install vCenter Converter,” on page 29

n

“Modify, Repair, or Remove vCenter Converter,” on page 31

n

“Uninstall vCenter Converter,” on page 31

n

“Install the vCenter Converter Client,” on page 32

n

“Enable or Disable the vCenter Converter Client,” on page 32

n

“Repair or Uninstall the vCenter Converter Client by Using the vCenter Converter Client Installer,” on
page 33

n

“Uninstall the vCenter Converter Client by Using the Windows Add or Remove Programs Utility,” on
page 33

Install vCenter Converter
You can use the vCenter Server installer or the vCenter Converter installer to add vCenter Converter
functionality to the vCenter Server 4.0 environment.
You can install the vCenter Converter CLI on multiple machines to access vCenter Server with an associated
vCenter Converter server. You can install the vCenter Converter CLI on the same machine as vCenter Converter
server, or on a different machine. See “Install and Run the vCenter Converter CLI on a Linux Computer,” on
page 76.
Prerequisites
The process for installing with the vCenter Converter installer is described here. The process for installing the
vCenter Converter plug-in as part of the vCenter Server installation process is described in the
vSphere Installation Guide.
Before you install vCenter Converter, confirm the following items:
n

Verify that your hardware meets the vCenter Converter system requirements. See “Operating System
Compatibility and Installation File Size Requirements,” on page 21.

n

vCenter Converter requires a connection to vCenter Server 4.0. Make sure that the vCenter Server is
powered on and that you have your login credentials to enter during the installation process.
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Procedure
1

Double-click the VMware-Converter.exe file and click Next.
If a dialog box appears with Modify, Repair, or Remove, the installer detected a previous
vCenter Converter installation.

2

On the End-User License Agreement page, select I accept the terms in the License Agreement and click
Next.

3

Select the location folder for vCenter Converter on the Destination Folder page and click Next.
The default location is C:\Program Files\VMware\Infrastructure\Converter. To install to another
location, click Change and browse for the new location.

4

Select the type of installation and click Next.
Option

Description

Typical

Installs the vCenter Converter server and the vCenter Converter CLI.

Custom

Select a vCenter Converter server, vCenter Converter CLI, or vCenter
Converter agent installation.

If your selection does not include vCenter Converter server, when the Installation Completed page
appears, click Finish.
5

Enter the host name or IP address and the port number for the vCenter Server to connect to.
If the default port (443) is already in use, enter an alternative port.
Each installation of vCenter Converter server must be associated with only one vCenter Server.

6

Enter the User Name and Password for the vCenter Server and click Next.

7

Enter the vSphere Client Web service ports or use the default ports and click Next.
n

HTTPS (default is 443)

n

HTTP (default is 80)

n

SOAP (default is 9085)

n

Web (default is 9086)

These ports allow communication between vCenter Converter components. If the default ports are already
in use, enter alternative ports.
8

Enter a host name, IP address, or DNS name to identify vCenter Converter Server on the network and click
Next.

9

On the Ready to Install the Program page, click Install.
If you click Cancel during the installation, the installed files are removed and the operating system is
returned to its original state.

10

When the Installation Completed page appears, click Finish.

vCenter Converter is installed and the client appears in the Available Plug-ins list of the vSphere Plug-in
Manager.
What to do next
You can now install the vCenter Converter client. See “Install the vCenter Converter Client,” on page 32.
If you installed the vCenter Converter agent on Windows 2000, Windows prompts you to restart your system.
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Modify, Repair, or Remove vCenter Converter
With the VMware vCenter Converter installer wizard, you can change the installed components of
vCenter Converter, check for and reinstall any damaged components, or uninstall vCenter Converter.
Procedure
1

To start the vCenter Converter installer, go to the folder that contains the installer file and double-click the
VMware-converter-4.1.0-<xxxxx>.exe file.
In this example, <xxxxx> is the build number. This file is on the application CD or in the local directory to
which you downloaded the installer.

2

Click Next.

3

On the Program Maintenance page, select an option and click Next.

4

Option

Description

Modify

Changes the installed components of vCenter Converter. This option takes
you to the Custom Setup page of the wizard, where you can make changes.

Repair

Checks for and reinstalls any damaged components of vCenter Converter.

Remove

Uninstalls vCenter Converter.

Click Remove.
On the Remove the Program page, you can remove all related files and registry entries that
vCenter Converter creates.
Alternatively, if you are modifying or repairing vCenter Converter, the page that appears is the Ready to
Modify the Program or the Ready to Repair the Program page, without any mention of file deletion.

What to do next
When the modifications or repairs are finished, you might have to restart your system before you can use
vCenter Converter.

Uninstall vCenter Converter
If you are prompted to uninstall vCenter Converter during an update installation, you can uninstall the
vCenter Converter components by using the Windows Add or Remove Programs utility from the Control
Panel.
You can uninstall only one component at a time.
Procedure
1

Log in as an Administrator to the Windows computer on which vCenter Converter is installed.

2

Select Start > Settings > Control Panel > Add or Remove Programs.

3

Select a vCenter Converter component and click Remove.

4

Click Yes to confirm that you want to remove the program and click Finish.

vCenter Converter and its components are uninstalled.
What to do next
You are now ready to update the vCenter Converter components.
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Install the vCenter Converter Client
After the vCenter Converter server is installed and registered with vCenter Server, the vCenter Converter client
is available to the vCenter Server client. You can access the vCenter Converter Import, Export, and Reconfigure
wizards and manage conversion tasks through the client.
Prerequisites
Before you install the vCenter Converter client, make sure that your hardware meets the vCenter Converter
client system requirements. See “vCenter Converter Client Requirements,” on page 22.
Procedure
1

Start the vSphere Client and connect to the vCenter Server associated with vCenter Converter.
You specified the associated vCenter Server when you installed vCenter Converter.

2

Select Plug-ins > Manage Plug-ins.

3

Select VMware vCenter Converter in the Available Plug-ins list and click Download and install.

4

After the installation is complete, verify that the module appears in the Installed Plug-ins list and that it
is enabled.

You can now access the vCenter Converter wizards to perform migrations in the vCenter Server environment.

Enable or Disable the vCenter Converter Client
To make the vCenter Converter client module available in the vSphere environment, you must enable it by
using the Plug-in Manager. After the client is enabled, you can also use the Plug-in Manager to disable it.
Disabling the plug-in does not uninstall it. Disabling turns off the features and functionality that the vCenter
Converter client provides for the vSphere Client you are using. Plug-ins are enabled by default when they are
installed.
Procedure
1

In the vSphere Client, select Plug-ins > Manage Plug-ins.

2

Click the Installed tab, right-click Vmware vCenter Converter and select Enable or Disable.

If you enabled the vCenter Converter client, it is now accessible in the vSphere Client interface. The vCenter
Converter Online Help is accessible from the Help menu.
What to do next
You can now use the vCenter Converter wizards to begin a conversion task.
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Repair or Uninstall the vCenter Converter Client by Using the vCenter
Converter Client Installer
If you have problems enabling or running the vCenter Converter client, you might need to repair or uninstall
the client. You can use the VMware vCenter Converter Client installer to uninstall the client. The installer also
allows you to repair the vCenter Converter client.
Procedure
1

To start the VMware vCenter Converter Client installer, go to the folder that contains the installer file and
double-click the VMware Converter Client.exe file.
The default location is C:\Program Files\VMware\Infrastructure\Converter Enterprise\docroot\vmc.

2

Click Next.

3

On the Program Maintenance page, select an option and click Next.

4

Option

Description

Repair

Checks for and reinstalls any damaged components of vCenter Converter
client.

Remove

Uninstalls vCenter Converter client.

On the Remove the Program page, Click Remove to remove all related files and registry entries that
vCenter Converter client creates.
Alternatively, if you are repairing vCenter Converter Client, the page that appears is the Ready to Repair
the Program page, without any mention of file deletion.

What to do next
When vCenter Converter client is repaired, you might have to restart your system before you can use the plugin.

Uninstall the vCenter Converter Client by Using the Windows Add or
Remove Programs Utility
When you upgrade vCenter Server or the vSphere Client environment, you might need to uninstall the
vCenter Converter client. You can use the Windows Add or Remove Programs utility in the Control Panel to
uninstall the client.
Procedure
1

Log in as an Administrator to the Windows computer on which the vCenter Converter client is installed.

2

Select Start > Settings > Control Panel > Add or Remove Programs.

3

Select VMware vCenter Converter Client and click Remove.

4

Click Yes to confirm that you want to remove the program and click Finish.

The vCenter Converter client is uninstalled.
What to do next
You are now ready to upgrade the client.
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With vCenter Converter, you can import physical machines, virtual machines, and system images into virtual
machines that vCenter Server manages.
To import physical machines that are not running, use the VMware vCenter Converter Boot CD, which is
available with the standalone vCenter Converter application.
The following list includes the required steps and associated concepts that you need to create an import task.
1

Preparing for the Conversion Process on page 36
Before you begin creating a virtual machine, you must determine the type of machine you are converting
and the destination for the new virtual machine.

2

Create a Separate Disk for Each Volume on page 36
To ease storage management, you can migrate to separate disks all volumes except the active and system
volumes. The active and system volumes are not separated if they reside on the same disk.

3

Start the Import Wizard on page 37
You use the vCenter Converter Import wizard to enter information about the source and destination
machines and select the task parameters for the conversion. The wizard is context-sensitive. You must
complete the steps in the wizard to start an import task.

4

Select a Source on page 37
vCenter Converter has several source machine type options from which you can create a virtual machine.

5

Select a Destination for a New Virtual Machine on page 42
You can import a virtual machine to run in an ESX/ESXi host that vCenter Server manages.

6

Customizing the Guest Operating System of the New Virtual Machine on page 43
After you create and configure a virtual machine, you can customize the identity and network settings
of the virtual machines's guest operating system so that it is ready to begin work immediately in the
target environment.

7

Schedule an Import Task on page 46
On the Schedule Task page of the Import wizard, you can set a task to run immediately or schedule it to
run at a later date. You can also schedule the frequency at which to run the task and set a retention policy
for the virtual machine.

8

Complete the Import Task on page 47
After you review your selections on the Ready to Complete page of the wizard, you can run the
conversion task.
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Preparing for the Conversion Process
Before you begin creating a virtual machine, you must determine the type of machine you are converting and
the destination for the new virtual machine.
Table 4-1. Source and Destination Options
Conversion object

Options

Source

n
n
n

Destination

n
n
n

Physical computer
VMware vSphere virtual machine (ESX/ESXi)
Standalone virtual machine
ESX/ESXi
ESX/ESXi that vCenter Server manages
VMware standalone virtual machine

Standalone virtual machines include VMware Workstation, VMware Server, Microsoft Virtual PC, and
Microsoft Virtual Server. Backup images include VCB, Acronis True Image 9, Symantec Backup Exec System
Recovery (formerly LiveState Recovery) 6.5 and 7.0, LiveState Recovery 3.0 and 6.0, and Norton Ghost 9, 10,
and 12 (.sv2i only).
You can choose the type of disk conversion, depending on your source and destination machines:
Convert all disks and
maintain size

Converts all disks unchanged. This is the only choice if the virtual machine you
are converting has a Linux guest operating system.

Select volumes and
resize to save or add
space

Allows you to enter a specific size.

Create a separate disk
for each volume

Creates a separate disk for each volume. (The active and system volumes are
not separated if they reside on the same disk.) You can then migrate disks across
independent datastores.

Create a Separate Disk for Each Volume
To ease storage management, you can migrate to separate disks all volumes except the active and system
volumes. The active and system volumes are not separated if they reside on the same disk.
Converting individual volumes to corresponding virtual disks and placing the individual disks across separate
datastores gives you more direct control over storage limitations.
You can create separate disks for any source machine. The destination can be a vSphere Client destination (an
instance of ESX/ESXi or ESX/ESXi that vCenter Server manages) or a hosted destination (Workstation). For
hosted destinations, all disks are stored in the same location.
When you select Create a separate disk for each volume, the Advanced Datastore page lists the new disks in
the order in which the volumes on the Source Data page appear. The active and system disks are always listed
first and can be on the same or on different disks, depending on their original configuration. To verify the new
disk to which a volume is assigned, compare the new size for each volume on the Source Data page with the
disk size on the Advanced Datastore page.
Procedure
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1

On the Source Data page, select the volumes to convert and specify their size.

2

Select Create a separate disk for each volume and click Next.

3

Type the IP address of the vCenter Server or the host where you want to store the virtual machine.
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4

Log in as administrator, enter your administrator password, and click Next.

5

Type a name for the new virtual machine, select the folder location for the machine, and click Next.

6

Select a host, cluster, or resource pool from which the virtual machine is to run and click Next.

7

Select the appropriate datastore for storing each disk and click Next.

The volumes you selected are saved to the relevant destination virtual disks.
What to do next
You are now ready to select a destination for the new virtual machine.

Start the Import Wizard
You use the vCenter Converter Import wizard to enter information about the source and destination machines
and select the task parameters for the conversion. The wizard is context-sensitive. You must complete the steps
in the wizard to start an import task.
The information you must provide depends on the location from which you start the wizard.
Procedure
1

Go to Start > Programs > VMware > VMware vSphere Client.

2

Type the host name or IP address of the vCenter Server associated with vCenter Converter.

3

Type an appropriate Windows domain user name and password, and click Login.

4

Start the Import wizard in one of several ways.
n

On the main vSphere Client menu, select Inventory and select a Host, Cluster, or Resource pool, then
select Import Machine.

n

In the inventory Hosts & Clusters view, right click a host, cluster, or resource pool, and select Import
Machine.

n

In the inventory Virtual Machines and Templates view, right-click a folder and select Import
Machine.

n

In the Scheduled Tasks view, select File > New > Scheduled Task. In the drop-down menu, select
Import a machine.

The Import wizard opens. Complete the wizard to add the conversion task to the task list.
What to do next
You are now ready to start the import process.

Select a Source
vCenter Converter has several source machine type options from which you can create a virtual machine.
You can select from the following source types:
Physical computer

Converts any running computer on a network to which you have remote access
and administrator privileges.

VMware vSphere Virtual
Machine

Converts a virtual machine that ESX/ESXi hosts or converts an ESX/ESXi virtual
machine that vCenter Server manages.

Other

Converts a standalone virtual machine or backup image, such as Workstation,
Vmware Server, VCB, or third-party virtual machines or disk images.

The following source types are supported for importing:
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n

Select a Physical Machine Source on page 38
You can select a remote physical machine as a source for your conversion.

n

Select ESX/ESXi or a vCenter Server Virtual Machine Source on page 39
You can select an ESX/ESXi or vCenter Server virtual machine as a source for your conversion.

n

Select a Standalone Virtual Machine, Backup Image, or Disk Image Source on page 40
You can import standalone virtual machines, such as Workstation, or convert third-party backup or disk
images to virtual machines.

n

Select a VCB Image Source on page 41
You can select a VCB backup image as a source for your conversion.

Select a Physical Machine Source
You can select a remote physical machine as a source for your conversion.
Prerequisites
The following conditions must be in place before you select a machine source for conversion:
n

The remote machine must be powered on.

n

You must have administrator privileges for the machine.

Procedure
1

On the Source page of the vCenter Converter Import wizard, click Next to go to the Source Type page.

2

Select Physical computer from the drop-down menu and click Next.

3

Type the host name or IP address of the remote physical machine to import, or select a machine from the
drop-down menu.

4

Type the domain and user name and password for the specified machine and click Next.
If vCenter Converter needs to install the vCenter Converter agent on the remote machine, a warning dialog
box appears.

5

On the Source Data page, select any volumes you do not want to import.
If you are hot cloning a physical computer, you can use only volume-based cloning.
If you select the system volume or active volume, a warning appears before you go to the next page.

6

(Optional) If you are performing volume-based cloning, select Ignore page file and hibernation file to
exclude these files.
The destination virtual machine has more free space if you exclude these files.

7

8
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Specify the volume size for each volume in the New Disk Space drop-down menus and click Next.
Option

Description

Maintain Size

Keeps the original size volume.

Min Size

Converts just the used portion from the volume, with a small amount of space
added.

<Type Size in GB>

Enter a specific size in gigabytes

<Type Size in MB>

Enter a specific size in megabytes.

(Optional) To convert individual volumes to corresponding virtual disks, select Create a separate disk
for each volume.
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What to do next
You can now select a destination for the new virtual machine. See “Select a Destination for a New Virtual
Machine,” on page 42.

Select ESX/ESXi or a vCenter Server Virtual Machine Source
You can select an ESX/ESXi or vCenter Server virtual machine as a source for your conversion.
Prerequisites
Before you begin, the source virtual machine must be shut down and powered off.
Procedure
1

On the Source page of the vCenter Converter Import wizard, click Next to go to the Source Type page.

2

Select VMware vSphere Virtual Machine in the drop-down menu and click Next.

3

On the Source Login page, select an ESX/ESXi or vCenter Server host that contains the virtual machine to
import and enter your user name and password.
The ESX /VC Server drop-down menu contains the identifiers or locations of the last 10 systems accessed.
Enter a new identifier.
Option

Action

ESX/ESXi

Select the virtual machine to convert from the list of the machines detected
on the ESX/ESXi machine you accessed.

ESX/ESXi that vCenter Server
manages

a
b

Select the source for the virtual machine in the vCenter Server virtual
machine inventory browser and click Next.
In the View drop-down menu, search the browser through one of two
views of the inventory: the default Hosts & Clusters view or the Virtual
Machines & Templates view.

4

Click Next.

5

Select a virtual machine to import and click Next.

6

To import all disks unchanged, make sure that Import all disks and maintain size is selected on the Source
Data page and click Next.
Import all disks and maintain size is the only choice if the virtual machine you are importing has a Linux
guest operating system.
Otherwise, select Select volumes and resize to save or add space. Page and hibernation files are ignored
during volume-based cloning.

7

Deselect any volumes you do not want to import.
If you select the system volume or active volume, a warning appears before you go to the next page.

8

9
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Specify the volume size for each volume in the New Disk Space drop-down menus and click Next.
Option

Description

Maintain Size

Keeps the original size volume.

Min Size

Converts just the used portion from the volume, with a small amount of space
added.

<Type Size in GB>

Enter a specific size in gigabytes

<Type Size in MB>

Enter a specific size in megabytes.

(Optional) To convert individual volumes to corresponding virtual disks, select Create a separate disk
for each volume.
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What to do next
You can now select a destination for the new virtual machine. See “Select a Destination for a New Virtual
Machine,” on page 42.

Select a Standalone Virtual Machine, Backup Image, or Disk Image Source
You can import standalone virtual machines, such as Workstation, or convert third-party backup or disk
images to virtual machines.
Prerequisites
Verify that your source virtual machine or backup image type is supported. See “Supported Sources for
Importing,” on page 24.
Procedure
1

On the Source page of the vCenter Converter Import wizard, click Next to go to the Source Type page.

2

Select Other in the drop-down menu and click Next.

3

Enter the UNC path and filename for the source virtual machine or image.

4

Enter the domain, user name, and password and click Next.

5

If the New Virtual Machine Reconfiguration page appears, you must select the required files from service
packs or hot fixes.
The required files are listed in the wizard. The Next button remains disabled until every item has a check
mark beside it.
a

Select one or more items from the list, click Folder Location, and enter the full UNC path to the folder
that contains the selected files.
For example, enter \\serverName\folderName.

6

7

b

Enter the credentials to access the specified location.

c

Repeat these steps for each required file, and when you finish, click Next.

(Optional) (Microsoft Windows NT only) A warning message advises you that the import process will
upgrade any NTFS partitions in the resulting virtual machine to a newer version of the NTFS file system.
To avoid upgrading your file system, stop the task.
a

Click No in the dialog box.

b

Click Cancel on the wizard page to end the import.

If the source you selected is password-protected, the Virtual Machine Login page appears. Type the
password and click Next.
If the source is not password protected, the wizard skips this page and presents the Source Data page.
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8

(Optional) If the virtual machine you are importing has a Linux guest operating system, to import all disks
unchanged, make sure that Import all disks and maintain size is selected on the Source Data page and
click Next.

9

Click Select volumes and resize to save or add space.
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10

Deselect any volumes you do not want to import.
If you select the system volume or active volume, a warning appears before you go to the next page.
Option

Action

Convert disks when the virtual
machine you are converting has a
Linux guest OS.

Select Import all disks and maintain size.

Resize the volumes.

Click Select volumes and resize to save or add space.
Page and Hibernation files are ignored during volume-based cloning.

Convert individual volumes to
corresponding disks.

Select Create a separate disk for each volume.

For additional information, see “Create a Separate Disk for Each Volume,” on page 36.
11

Specify the volume size for each volume in the New Disk Space drop-down menus and click Next.
Option

Description

Maintain Size

Keeps the original size volume.

Min Size

Converts just the used portion from the volume, with a small amount of space
added.

<Type Size in GB>

Enter a specific size in gigabytes

<Type Size in MB>

Enter a specific size in megabytes.

What to do next
You can now select a destination for the new virtual machine. See “Select a Destination for a New Virtual
Machine,” on page 42.

Select a VCB Image Source
You can select a VCB backup image as a source for your conversion.
Procedure
1

On the Source page of the vCenter Converter Import wizard, click Next to go to the Source Type page.

2

Select Other in the drop-down menu and click Next.

3

Enter the UNC path and filename for the source VCB image.

4

Enter the domain and user name and password and click Next.

5

Click Select volumes and resize to save or add space.
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6

Deselect any volumes you do not want to import.
If you select the system volume or active volume, a warning appears before you go to the next page.

7

Option

Description

Convert disks when the virtual
machine you are converting has a
Linux guest OS.

Select Import all disks and maintain size.

Resize the volumes.
Page and Hibernation files are
ignored during volume-based
cloning.

Click Select volumes and resize to save or add space.

Convert individual volumes to
corresponding disks.

Select Create a separate disk for each volume.
For additional information, see “Create a Separate Disk for Each Volume,”
on page 36.

Specify the volume size for each volume in the New Disk Space drop-down menus and click Next.
Option

Description

Maintain Size

Keeps the original size volume.

Min Size

Converts just the used portion from the volume, with a small amount of space
added.

<Type Size in GB>

Enter a specific size in gigabytes

<Type Size in MB>

Enter a specific size in megabytes.

What to do next
You can now select a destination for the new virtual machine. See “Select a Destination for a New Virtual
Machine,” on page 42.

Select a Destination for a New Virtual Machine
You can import a virtual machine to run in an ESX/ESXi host that vCenter Server manages.
Procedure
1

On the Destination page, click Next to go to the Virtual Machine Name and Folder page.

2

Name the virtual machine, select a destination folder within the vCenter Server inventory, and click
Next.

3

(Optional) Select a host, cluster, or resource pool from which to run the virtual machine.

4

a

On the Host or Cluster page, select the host, cluster, or resource pool and click Next.

b

On the Host page, select a host and click Next.

c

On the Resource Pool page, select a resource pool and click Next.

Specify the datastore for the virtual machine’s configuration files and disks and click Next.
All datastores and their available space appear in the Datastore list. You must select a datastore or
datastores large enough to contain the selected disks.

5

(Optional) To distribute the disks over several datastores, click Advanced.
Select the datastore for each disk and file from the drop-down menus.
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6

On the Networks page, map the virtual machine’s network adapters to a vCenter Server network.
You can also select the number of adapters to map.

7

Click Next.

What to do next
On the Customization page, you can select configuration options for the guest operating system.

Customizing the Guest Operating System of the New Virtual Machine
After you create and configure a virtual machine, you can customize the identity and network settings of the
virtual machines's guest operating system so that it is ready to begin work immediately in the target
environment.
The customization process varies depending on the guest operating system to be used in the new virtual
machine. You can install VMware Tools, customize a guest operating system, remove System Restore
checkpoints, or any combination of these options.
vCenter Converter does not support customization and VMware Tools installation for Windows NT guest
operating systems.
To skip customization and set the task parameters, see “Schedule an Import Task,” on page 46.

Install VMware Tools
VMware Tools is a suite of utilities that enhances the performance of the virtual machine's guest operating
system and improves management of the virtual machine. For details about VMware Tools, see the vSphere
Basic System Administration guide.
Install VMware Tools on the target virtual machine.
Procedure
u

On the Customization page, ensure that Install VMware Tools is selected.

What to do next
You can continue setting the configuration options or click Next to schedule the task.

Customize the Identity of the New Virtual Machine
You can enter a name for the virtual machine, change the time zone, and modify the network properties.
If the Customize option is unavailable, you must install the Microsoft Sysprep tools on your vCenter Server
machine in the appropriate location. For example, C:\Documents and Settings\All Users\Application Data
\VMware\VMware VCENTER\sysprep.
You can customize the following information:
n

Change the computer information for identifying a virtual machine on a network.

n

Enter server license information.

n

Change the time zone for a virtual machine.

n

Modify the properties for each network interface.
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Procedure
1

On the Customization page, select Customize the identity of the virtual machine and click Next.

2

On the Computer Information page, customize any of the following fields.
Option

Description

Computer Name

A unique name to identify the virtual machine on the network. Valid
characters include A-Z, a-z, 0-9, and the hyphen. The underscore (_) is
nonstandard, but vCenter Converter permits its use. The limit is 63
characters. The computer name cannot consist only of numerals.

Owner Name

Valid characters include all printable characters. The limit is 63 characters.

Organization

Valid characters include all printable characters. The limit is 63 characters.

Generate New Security ID (SID)

Generates a new security identifier. By default, the security ID is preselected
for Windows Vista systems.

3

Click Next.

4

Enter the Windows licensing information for this virtual machine, if necessary, and click Next.
You can leave the Product ID field blank and move to the next page.
The Include Server License Information check box only applies to Microsoft Windows 2000 Server and
Microsoft Windows Server 2003 operating systems. The Server License Mode buttons are disabled if the
check box is not selected. This action does not apply to Windows Vista.

5

Select a time zone from the drop-down menu and click Next.
If network interfaces need to be set, the Network Interface Settings page appears.

6

7

8
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(Optional) To customize your network adapter settings, select the adapter on the Network Interface
Settings page and click Customize.
n

The Reset All button is enabled if one or more network adapters were modified. Click Reset All to
return all settings for all adapters to the default and click Next.

n

By default, every network adapter obtains the IP address and DNS server address from the Dynamic
Host Configuration Protocol (DHCP). If you prefer to use the default settings, click Next.

(Optional) In the Network Properties dialog box, modify the properties of any network adapters.
Field

Description

General

Use this field only to manually enter the IP address and DNS server address.

DNS

Specify the DNS connections by entering DNS suffixes.
n For each DNS suffix you enter, click Add.
n If you are entering multiple DNS suffixes, use Move Up and Move Down
to change the order in which a virtual machine is to use the connections.

WINS

Specify the primary and secondary WINS addresses by typing the IP
addresses in the entry boxes.

Click OK to return to the Network Interface Settings page and click Next.
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9

10

On the Workgroup or Domain page, select how the virtual machine participates in a network.
Field

Description

Workgroup

Valid characters include A-Z, a-z, 0-9, space, and the hyphen (-). Maximum
length is 15 characters.

Windows Server Domain

The text box must have a value. Valid characters include A-Z, a-z, 0-9, space,
period, and the hyphen (-). Each label delineated by a period can be 63
characters. The entire text string can be up to 254 characters. A user name
and password are required.

Click Next.

vCenter Converter configures the guest operating system of the new virtual machine according to your settings.
What to do next
After you complete the options on the Customization page, you can set the parameters for the conversion or
reconfiguration task.

Remove System Restore Checkpoints
Removing all System Restore checkpoints prevents the target machine from reverting to a preconversion state.
When you want the target virtual machine to be a replica of the source system, do not remove the System
Restore checkpoints. Otherwise, regardless of the cloning mode, remove all System Restore checkpoints.
CAUTION If you restore a checkpoint in the target virtual machine that was created before you cloned the source
machine, you can damage the system and cause the target virtual machine to become unbootable.
For more information about cloning modes, see “Cloning Modes,” on page 15.
When you remove System Restore checkpoints, be aware of the following situations:
n

System Restore is enabled on Windows Vista, Windows XP, and Windows Server 2008 systems by default.

n

By default, System Restore is not installed on Windows Server 2003. If it is installed, a System Restore tab
is available in the System Properties dialog box of the Windows machine.

n

For any cloning mode of Windows XP sources, the Remove all system restore checkpoints option is
selected by default.

n

For volume-based, file-level cloning of Windows Vista and Windows Server 2008 sources, by default
vCenter Converter does not copy System Restore checkpoints to the target virtual machine. The Remove
all system restore checkpoints option is ignored.

Procedure
u

On the Customization page, select Remove all system restore checkpoints.

vCenter Converter does not copy the system restore checkpoints from the source to the destination virtual
machine.
What to do next
You can continue setting configuration options or click Next to schedule a conversion or reconfiguration task.
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Schedule an Import Task
On the Schedule Task page of the Import wizard, you can set a task to run immediately or schedule it to run
at a later date. You can also schedule the frequency at which to run the task and set a retention policy for the
virtual machine.
If you start the Import wizard from vCenter Server, you must schedule the task.

Schedule the Task to Run Immediately
You can schedule a task to run before other tasks in the queue.
Procedure
u

On the Schedule Task page, select Run this task immediately and click Next.

The task appears in the Recent Tasks list as well as on the Tasks & Events tab. A status bar indicates the percent
complete. When the conversion is complete, the status field reports Completed.
What to do next
Review a summary of your selections on the Ready to Complete page and start the task.

Schedule the Task to Run at a Specific Time
You can select the time at which you want the task to run.
Procedure
1

On the Schedule Task page, select Schedule Later.

2

Enter a display name for the task.

3

Enter a description of the task.

4

Enter the start date and time and click Next.

The task appears in the Scheduled Tasks list where you can monitor and manage it.
What to do next
Review a summary of your selections on the Ready to Complete page and start the task.

Schedule the Task Frequency
With vCenter Converter, you can select the frequency at which to run the task.
Procedure
1

On the Schedule Task page, click the Schedule the task button.

2

Enter a task name and a task description.

3

In the Frequency drop-down menu, select the frequency at which to run the task.

4

Enter the start and end dates.
You can schedule an ongoing task by selecting No end date or you can select a set number of occurrences
after which the task should end.

46

5

Enter the time for the task to start.

6

(Optional) In the Retention Policy drop-down menu, you can select how many copies of the virtual
machine to keep.
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When you start the conversion, the task is added to the task list and runs according to the task parameters that
you specified.
What to do next
Review a summary of your selections on the Ready to Complete page and start the task.

Complete the Import Task
After you review your selections on the Ready to Complete page of the wizard, you can run the conversion
task.
Procedure
1

Review the summary of the settings for the new virtual machine.

2

Indicate whether you want vCenter Server to power on the resultant virtual machine after it is created.

3

Click Finish to close the wizard and display the Task View with the import job in the task list.

If you scheduled the task to run immediately, it appears in the Recent Tasks list as well as on the Tasks & Events
tab. A status bar indicates the percent complete. When the import is finished, the status field reports Completed.
If you scheduled a task to run at a later time, it appears on the Scheduled Tasks page.
What to do next
After you create a task, you can monitor and manage it in the vSphere Client.
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Exporting Machines

5

With vCenter Converter, you can export virtual machines that vCenter Server manages to managed formats
(an instance of ESX/ESXi or ESX/ESXi that vCenter Server or VCENTER 2.x manages) or hosted formats (for
example, Workstation or VMware Server). The export process converts the source to a virtual machine in the
format you specify.
The following list includes the required steps and associated concepts that you need to create an export task.
1

Start the vCenter Converter Export Wizard on page 49
You use the vCenter Converter Exportwizard to enter information about the source and destination
machines and select the task parameters for the conversion. The wizard is context sensitive. You must
complete the steps in the wizard to start an export task.

2

Select a Virtual Machine Source on page 50
In most cases, you select the virtual machine to export before you start the Export wizard. If you start
the wizard by creating a scheduled task, you must select the source virtual machine.

3

Selecting a Destination for the New Virtual Machine on page 51
You must select a destination for the virtual machine you are exporting.

4

Customizing the Guest Operating System of the New Virtual Machine on page 52
After you create and configure a virtual machine, you can customize the identity and network settings
of the virtual machines's guest operating system so that it is ready to begin work immediately in the
target environment.

5

Schedule an Export Task on page 55
On the Schedule Task page of the Export wizard, you can set a task to run immediately or schedule it to
run at a later date. You can also schedule the frequency at which to run the task and set a retention policy
for the virtual machine.

6

Complete the Export on page 56
After you review your selections on the Ready to Complete page of the wizard, you can schedule the
conversion task.

Start the vCenter Converter Export Wizard
You use the vCenter Converter Exportwizard to enter information about the source and destination machines
and select the task parameters for the conversion. The wizard is context sensitive. You must complete the steps
in the wizard to start an export task.
The information you must provide depends on the location from which you start the wizard. For example, if
you start the Export wizard from a host, the exported virtual machine will be located on that host, and the
wizard does not ask you for a destination. If you start the wizard from the Scheduled Tasks view, the wizard
asks you to select a host.
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Procedure
1

Go to Start > Programs > VMware > VMware Client.

2

Type the host name or IP address of the vCenter Server associated with vCenter Converter.

3

Type an appropriate Windows domain user name and password and click Login.

4

Start the Export wizard in one of several ways.

5

n

In the Virtual Machine and Templates Inventory view, right-click a virtual machine and select
Export.

n

Right-click a virtual machine name in any view and select Export.

n

In the Scheduled Tasks view, select File > New > Scheduled Task. In the drop-down menu, select
Export a machine.

Complete the wizard to add the conversion task to the task list.

What to do next
You can now select a source.

Select a Virtual Machine Source
In most cases, you select the virtual machine to export before you start the Export wizard. If you start the
wizard by creating a scheduled task, you must select the source virtual machine.
Procedure
1

On the Source page, click Next.
If you already selected the virtual machine to export, it is listed as the source.

2

Specify the source virtual machine in the vCenter Server virtual machine inventory browser and click
Next.
You can search the browser through one of the following views of the inventory:

3

n

The Hosts & Clusters view is selected by default.

n

From the drop-down menu, select the Virtual Machines & Templates view.

To export all disks unchanged, make sure that Import all disks and maintain size is selected on the Source
Data page and click Next.
Otherwise, select Select volumes and resize to save or add space. Page and hibernation files are ignored
during volume-based cloning.

4

(Optional) If you are exporting specific volumes, deselect any volumes that you do not want to export.
Do not deselect the system or active volumes.

5

(Optional) If you are performing volume-based cloning, select Ignore page file and hibernation file to
exclude these files.
The destination virtual machine has more free space if you exclude these files. You can choose to include
the files.

6

50

Specify the volume size for each volume in the New Disk Space drop-down menus and click Next.
Option

Description

Maintain Size

Keeps the original size volume.

Min Size

Converts just the used portion from the volume, with a small amount of space
added.
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Option

Description

<Type Size in GB>

Enter a specific size in gigabytes

<Type Size in MB>

Enter a specific size in megabytes.

What to do next
You can now select a destination for the new virtual machine.

Selecting a Destination for the New Virtual Machine
You must select a destination for the virtual machine you are exporting.
You can export your source machine to managed or hosted destinations.
n

Managed destinations: ESX/ESXi or ESX/ESXi that vCenter Server 4.0 or VCENTER 2.x manages

n

Hosted destinations: Workstation or VMware Server

A complete list of supported destinations is provided in “Supported Destinations for Exporting,” on
page 26.

Select a Managed Destination
You can export a virtual machine to use with ESX/ESXi or an ESX/ESXi host that vCenter Server manages.
Procedure
1

Click Next on the Destination page to go to the Destination Type page.

2

Select vSphere Virtual Machine from the drop-down menu and click Next.

3

Type or select the ESX/ESXi or vCenter Server host to export the virtual machine to.
The ESX/VC Server drop-down menu contains the identifiers or locations of the last ten systems logged
in to. You can type in a new identifier.

4

Enter a user name and password and click Next.

5

On the Virtual Machine Name and Folder page, enter the name to assign to the virtual machine, select a
destination folder from the vCenter Server inventory list, and click Next.

6

On the Host or Cluster page, select the host, cluster, or resource pool from which you want to run the
exported virtual machine and click Next.

7

(Optional) Select a host or resource pool from which to run the virtual machine.

8

n

On the Host page, select a host and click Next.

n

On the Resource Pool page, select a resource pool and click Next.

Select a datastore for the virtual machine’s configuration files and disks and click Next.
All datastores and their available space appear in this panel. You must select a datastore large enough to
contain the selected disks.

9

10

Distribute the disks over several datastores.
a

Click Advanced to see the list of disks and the virtual machine configuration file.

b

Select a datastore for each disk and file from the drop-down menus.

On the Networks page, map the virtual machine network adapters to a vCenter Server network and click
Next.
The Networks panel has drop-down menus that contain the networks that are available at the destination
location. You can also set the number of adapters.
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What to do next
On the Customization page, you can select configuration options for the guest operating system.

Select a Hosted Destination
You can export a virtual machine for use with Workstation, VMware Fusion, VMware Server, Player, or
VMware ACE.
Procedure
1

On the Destination page, click Next to go to the Destination Type page.

2

Select Other VMware Virtual Machine from the drop-down menu and click Next.

3

Type the name to assign to the virtual machine and enter the destination location.
The location must be a UNC path accessible to the vCenter Converter server.

4

Type the domain, user name, and password for the location you entered.

5

Select the type of virtual machine to create and click Next.

6

On the VM Options page, select the options for the virtual disks.

7

n

Allocate all disk space now for better performance provides the exported virtual machine with all
of the space allocated to the source virtual machine. This option provides somewhat better
performance for the virtual machine.

n

Allow virtual disk files to grow starts with small virtual disk files that can increase as needed, until
they reach the size of the source disks.

n

Select the Split disk into 2 GB files check box to support virtual disks on FAT file systems.

On the Networks page, map the virtual machine’s network adapters to a bridged, host-only, or NAT
network, and click Next.

What to do next
On the Customization page, you can select configuration options for the guest operating system.

Customizing the Guest Operating System of the New Virtual Machine
After you create and configure a virtual machine, you can customize the identity and network settings of the
virtual machines's guest operating system so that it is ready to begin work immediately in the target
environment.
The customization process varies depending on the guest operating system to be used in the new virtual
machine. You can install VMware Tools, customize a guest operating system, remove System Restore
checkpoints, or any combination of these options.
vCenter Converter does not support customization and VMware Tools installation for Windows NT guest
operating systems.
To skip customization and set the task parameters, see “Schedule an Export Task,” on page 55.

Install VMware Tools
VMware Tools is a suite of utilities that enhances the performance of the virtual machine's guest operating
system and improves management of the virtual machine. For details about VMware Tools, see the vSphere
Basic System Administration guide.
You can only install VMware Tools for ESX/ESXi, vCenter Server 4.0, VirtualCenter 2.x, Workstation 6, VMware
Server 1, 2, VMware Fusion 1, VMware Player 2, and ACE 2 destinations.
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Procedure
u

On the Customization page, ensure that Install VMware Tools is selected and click Next.

What to do next
You can continue selecting the configuration options or click Next to schedule a conversion or reconfiguration
task.

Customize the Identity of the New Virtual Machine
You can enter a name for the virtual machine, change the time zone, and modify the network properties.
If the Customize option is unavailable, you must install the Microsoft Sysprep tools on your vCenter Server
machine in the appropriate location. For example, C:\Documents and Settings\All Users\Application Data
\VMware\VMware VCENTER\sysprep.
You can customize the following information:
n

Change the computer information for identifying a virtual machine on a network.

n

Enter server license information.

n

Change the time zone for a virtual machine.

n

Modify the properties for each network interface.

Procedure
1

On the Customization page, select Customize the identity of the virtual machine and click Next.

2

On the Computer Information page, customize any of the following fields.
Option

Description

Computer Name

A unique name to identify the virtual machine on the network. Valid
characters include A-Z, a-z, 0-9, and the hyphen. The underscore (_) is
nonstandard, but vCenter Converter permits its use. The limit is 63
characters. The computer name cannot consist only of numerals.

Owner Name

Valid characters include all printable characters. The limit is 63 characters.

Organization

Valid characters include all printable characters. The limit is 63 characters.

Generate New Security ID (SID)

Generates a new security identifier. By default, the security ID is preselected
for Windows Vista systems.

3

Click Next.

4

Enter the Windows licensing information for this virtual machine, if necessary, and click Next.
You can leave the Product ID field blank and move to the next page.
The Include Server License Information check box only applies to Microsoft Windows 2000 Server and
Microsoft Windows Server 2003 operating systems. The Server License Mode buttons are disabled if the
check box is not selected. This action does not apply to Windows Vista.

5

Select a time zone from the drop-down menu and click Next.
If network interfaces need to be set, the Network Interface Settings page appears.
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6

7

(Optional) To customize your network adapter settings, select the adapter on the Network Interface
Settings page and click Customize.
n

The Reset All button is enabled if one or more network adapters were modified. Click Reset All to
return all settings for all adapters to the default and click Next.

n

By default, every network adapter obtains the IP address and DNS server address from the Dynamic
Host Configuration Protocol (DHCP). If you prefer to use the default settings, click Next.

(Optional) In the Network Properties dialog box, modify the properties of any network adapters.
Field

Description

General

Use this field only to manually enter the IP address and DNS server address.

DNS

Specify the DNS connections by entering DNS suffixes.
n For each DNS suffix you enter, click Add.
n If you are entering multiple DNS suffixes, use Move Up and Move Down
to change the order in which a virtual machine is to use the connections.

WINS

Specify the primary and secondary WINS addresses by typing the IP
addresses in the entry boxes.

8

Click OK to return to the Network Interface Settings page and click Next.

9

On the Workgroup or Domain page, select how the virtual machine participates in a network.

10

Field

Description

Workgroup

Valid characters include A-Z, a-z, 0-9, space, and the hyphen (-). Maximum
length is 15 characters.

Windows Server Domain

The text box must have a value. Valid characters include A-Z, a-z, 0-9, space,
period, and the hyphen (-). Each label delineated by a period can be 63
characters. The entire text string can be up to 254 characters. A user name
and password are required.

Click Next.

vCenter Converter configures the guest operating system of the new virtual machine according to your settings.
What to do next
After you complete the options on the Customization page, you can set the parameters for the conversion or
reconfiguration task.

Remove System Restore Checkpoints
Removing all System Restore checkpoints prevents the target machine from reverting to a preconversion state.
When you want the target virtual machine to be a replica of the source system, do not remove the System
Restore checkpoints. Otherwise, regardless of the cloning mode, remove all System Restore checkpoints.
CAUTION If you restore a checkpoint in the target virtual machine that was created before you cloned the source
machine, you can damage the system and cause the target virtual machine to become unbootable.
For more information about cloning modes, see “Cloning Modes,” on page 15.
When you remove System Restore checkpoints, be aware of the following situations:
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n

System Restore is enabled on Windows Vista, Windows XP, and Windows Server 2008 systems by default.

n

By default, System Restore is not installed on Windows Server 2003. If it is installed, a System Restore tab
is available in the System Properties dialog box of the Windows machine.
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n

For any cloning mode of Windows XP sources, the Remove all system restore checkpoints option is
selected by default.

n

For volume-based, file-level cloning of Windows Vista and Windows Server 2008 sources, by default
vCenter Converter does not copy System Restore checkpoints to the target virtual machine. The Remove
all system restore checkpoints option is ignored.

Procedure
u

On the Customization page, select Remove all system restore checkpoints.

vCenter Converter does not copy the system restore checkpoints from the source to the destination virtual
machine.
What to do next
You can continue setting configuration options or click Next to schedule a conversion or reconfiguration task.

Schedule an Export Task
On the Schedule Task page of the Export wizard, you can set a task to run immediately or schedule it to run
at a later date. You can also schedule the frequency at which to run the task and set a retention policy for the
virtual machine.

Schedule the Task to Run Immediately
You can schedule a task to run before other tasks in the queue.
Procedure
u

On the Schedule Task page, select Run this task immediately and click Next.

The task appears in the Recent Tasks list as well as on the Tasks & Events tab. A status bar indicates the percent
complete. When the conversion is complete, the status field reports Completed.
What to do next
Review a summary of your selections on the Ready to Complete page and start the task.

Schedule the Task to Run at a Specific Time
You can select the time at which you want the task to run.
Procedure
1

On the Schedule Task page, select Schedule Later.

2

Enter a display name for the task.

3

Enter a description of the task.

4

Enter the start date and time and click Next.

The task appears in the Scheduled Tasks list where you can monitor and manage it.
What to do next
Review a summary of your selections on the Ready to Complete page and start the task.
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Schedule the Task Frequency
With vCenter Converter, you can select the frequency at which to run the task.
Procedure
1

On the Schedule Task page, click the Schedule the task button.

2

Enter a task name and a task description.

3

In the Frequency drop-down menu, select the frequency at which to run the task.

4

Enter the start and end dates.
You can schedule an ongoing task by selecting No end date or you can select a set number of occurrences
after which the task should end.

5

Enter the time for the task to start.

6

(Optional) In the Retention Policy drop-down menu, you can select how many copies of the virtual
machine to keep.

When you start the conversion, the task is added to the task list and runs according to the task parameters that
you specified.
What to do next
Review a summary of your selections on the Ready to Complete page and start the task.

Complete the Export
After you review your selections on the Ready to Complete page of the wizard, you can schedule the conversion
task.
Procedure
1

Review the summary of the settings for the new virtual machine.

2

Click Finish to close the wizard and display the Task view with the export job in the task list.

If you scheduled the task to run immediately, it appears in the Recent Tasks list, as well as on the Tasks &
Events page. You can view the progress in the Task Progress tab.
If you scheduled a task to run at a later time, it appears on the Scheduled Tasks page.
What to do next
After you create a task, you can monitor and manage it in the vSphere Client.
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6

You can use vCenter Converter to reconfigure any Windows virtual machines that vCenter Server manages.
You can use the Reconfigure wizard to install VMware Tools on a virtual machine and customize the identity
of the new virtual machine.
vCenter Converter does not support customization and VMware Tools installation for Windows NT guest
operating systems.
The following list includes the required steps and associated concepts that you need to create a reconfiguration
task.
1

Start the Reconfigure Wizard on page 57
You use the vCenter Converter Reconfigure wizard to enter information about the virtual machine to
reconfigure. The wizard is context-sensitive. You must complete the steps in the wizard to start a
reconfiguration task.

2

Customizing the Guest Operating System of the New Virtual Machine on page 58
On the Reconfigure wizard Customization page, you can install VMware Tools, customize a guest
operating system, remove System Restore checkpoints, or perform any combination of these options,
depending on the guest operating system.

3

Complete the Reconfiguration on page 60
After you review your selections on the Ready to Complete page of the wizard, you can schedule the
conversion task or go back and change a setting.

Start the Reconfigure Wizard
You use the vCenter Converter Reconfigure wizard to enter information about the virtual machine to
reconfigure. The wizard is context-sensitive. You must complete the steps in the wizard to start a
reconfiguration task.
Prerequisites
The vCenter Converter client must be enabled in the vSphere Plug-in Manager.
Procedure
1

Go to Start > Programs > VMware > VMware vSphere Client.

2

Type the host name or IP address of the vCenter Server associated with vCenter Converter.

3

Type an appropriate Windows domain user name and password and click Log in.

4

Right-click a virtual machine in any inventory or task view and select Reconfigure to start the Reconfigure
wizard.

VMware, Inc.

57

vCenter Converter Administration Guide

What to do next
You are now ready to begin the customization process.

Customizing the Guest Operating System of the New Virtual Machine
On the Reconfigure wizard Customization page, you can install VMware Tools, customize a guest operating
system, remove System Restore checkpoints, or perform any combination of these options, depending on the
guest operating system.
The customization process varies depending on the guest operating system to be used in the new virtual
machine. You can install VMware Tools, customize a guest operating system, remove System Restore
checkpoints, or any combination of these options.
vCenter Converter does not support customization and VMware Tools installation for Windows NT guest
operating systems.

Install VMware Tools
VMware Tools is a suite of utilities that enhances the performance of the virtual machine's guest operating
system and improves management of the virtual machine. For details about VMware Tools, see the vSphere
Basic System Administration guide.
Install VMware Tools on the virtual machine you are reconfiguring.
Procedure
u

On the Customization page, ensure that Install VMware Tools is selected and click Next.

What to do next
You can continue selecting the configuration options or click Next to schedule the task.

Customize the Identity of the New Virtual Machine
You can enter a name for the virtual machine, change the time zone, and modify the network properties.
If the Customize option is unavailable, you must install the Microsoft Sysprep tools on your vCenter Server
machine in the appropriate location. For example, C:\Documents and Settings\All Users\Application Data
\VMware\VMware VCENTER\sysprep.
You can customize the following information:
n

Change the computer information for identifying a virtual machine on a network.

n

Enter server license information.

n

Change the time zone for a virtual machine.

n

Modify the properties for each network interface.

Procedure
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1

On the Customization page, select Customize the identity of the virtual machine and click Next.

2

On the Computer Information page, customize any of the following fields.
Option

Description

Computer Name

A unique name to identify the virtual machine on the network. Valid
characters include A-Z, a-z, 0-9, and the hyphen. The underscore (_) is
nonstandard, but vCenter Converter permits its use. The limit is 63
characters. The computer name cannot consist only of numerals.

Owner Name

Valid characters include all printable characters. The limit is 63 characters.

VMware, Inc.

Chapter 6 Reconfiguring Machines

Option

Description

Organization

Valid characters include all printable characters. The limit is 63 characters.

Generate New Security ID (SID)

Generates a new security identifier. By default, the security ID is preselected
for Windows Vista systems.

3

Click Next.

4

Enter the Windows licensing information for this virtual machine, if necessary, and click Next.
You can leave the Product ID field blank and move to the next page.
The Include Server License Information check box only applies to Microsoft Windows 2000 Server and
Microsoft Windows Server 2003 operating systems. The Server License Mode buttons are disabled if the
check box is not selected. This action does not apply to Windows Vista.

5

Select a time zone from the drop-down menu and click Next.
If network interfaces need to be set, the Network Interface Settings page appears.

6

7

(Optional) To customize your network adapter settings, select the adapter on the Network Interface
Settings page and click Customize.
n

The Reset All button is enabled if one or more network adapters were modified. Click Reset All to
return all settings for all adapters to the default and click Next.

n

By default, every network adapter obtains the IP address and DNS server address from the Dynamic
Host Configuration Protocol (DHCP). If you prefer to use the default settings, click Next.

(Optional) In the Network Properties dialog box, modify the properties of any network adapters.
Field

Description

General

Use this field only to manually enter the IP address and DNS server address.

DNS

Specify the DNS connections by entering DNS suffixes.
n For each DNS suffix you enter, click Add.
n If you are entering multiple DNS suffixes, use Move Up and Move Down
to change the order in which a virtual machine is to use the connections.

WINS

Specify the primary and secondary WINS addresses by typing the IP
addresses in the entry boxes.

8

Click OK to return to the Network Interface Settings page and click Next.

9

On the Workgroup or Domain page, select how the virtual machine participates in a network.

10

Field

Description

Workgroup

Valid characters include A-Z, a-z, 0-9, space, and the hyphen (-). Maximum
length is 15 characters.

Windows Server Domain

The text box must have a value. Valid characters include A-Z, a-z, 0-9, space,
period, and the hyphen (-). Each label delineated by a period can be 63
characters. The entire text string can be up to 254 characters. A user name
and password are required.

Click Next.

vCenter Converter configures the guest operating system of the new virtual machine according to your settings.
What to do next
After you complete the options on the Customization page, you can set the parameters for the conversion or
reconfiguration task.
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Remove System Restore Checkpoints
Removing all System Restore checkpoints prevents the target machine from reverting to a preconversion state.
When you want the target virtual machine to be a replica of the source system, do not remove the System
Restore checkpoints. Otherwise, regardless of the cloning mode, remove all System Restore checkpoints.
CAUTION If you restore a checkpoint in the target virtual machine that was created before you cloned the source
machine, you can damage the system and cause the target virtual machine to become unbootable.
For more information about cloning modes, see “Cloning Modes,” on page 15.
When you remove System Restore checkpoints, be aware of the following situations:
n

System Restore is enabled on Windows Vista, Windows XP, and Windows Server 2008 systems by default.

n

By default, System Restore is not installed on Windows Server 2003. If it is installed, a System Restore tab
is available in the System Properties dialog box of the Windows machine.

n

For any cloning mode of Windows XP sources, the Remove all system restore checkpoints option is
selected by default.

n

For volume-based, file-level cloning of Windows Vista and Windows Server 2008 sources, by default
vCenter Converter does not copy System Restore checkpoints to the target virtual machine. The Remove
all system restore checkpoints option is ignored.

Procedure
u

On the Customization page, select Remove all system restore checkpoints.

vCenter Converter does not copy the system restore checkpoints from the source to the destination virtual
machine.
What to do next
You can continue setting configuration options or click Next to schedule a conversion or reconfiguration task.

Complete the Reconfiguration
After you review your selections on the Ready to Complete page of the wizard, you can schedule the conversion
task or go back and change a setting.
Procedure
1

Review the summary of the settings for the new virtual machine.

2

Click Finish to close the wizard and display the Task View with the reconfiguration job in the task list.

If you scheduled the task to run immediately, it appears in the Recent Tasks list as well as on the Tasks & Events
tab. You can view the progress on the Task Progress tab.
If you scheduled a task to run at a later time, it appears on the Scheduled Tasks page.
What to do next
After you reconfigure the virtual machine, you can monitor and manage it in the vSphere Client.
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7

vCenter Converter provides a task manager for managing migrations. After you create a task using one of the
vCenter Converter wizards to set up how to import, export, or customize a machine, you can use the
vSphere Client Task view to manage how tasks run, to edit tasks, to look at the progress of tasks, and more.
Managing vCenter Converter tasks is similar to managing other vCenter Server tasks. For general information
about task management, see the vSphere Basic System Administration guide.
You cannot schedule reconfiguration tasks.
This chapter includes the following topics:
n

“Displaying and Monitoring vCenter Converter Tasks,” on page 61

n

“Copy a Task,” on page 63

n

“Edit a Scheduled Task Immediately,” on page 63

n

“Run a Scheduled Task Immediately,” on page 64

n

“Cancel a Task,” on page 64

n

“Remove a Task,” on page 64

Displaying and Monitoring vCenter Converter Tasks
The way in which you monitor vCenter Converter tasks can vary, depending on your vSphere Client inventory.
The vSphere Client provides the following ways to monitor current, completed, or scheduled vCenter
Converter tasks:
n

The Tasks view on the Tasks & Events tab displays a list of current and completed tasks for the selected
inventory object.

n

The Recent Tasks panel displays a list of current and recently completed tasks for all inventory objects.

n

The Scheduled Tasks view displays a list of scheduled tasks for all inventory objects.

Monitor the Status of a Task for an Inventory Object
You can use vCenter Converter to monitor the status of scheduled conversion tasks in vSphere Client. You can
check whether the task is queued, in progress, successfully completed, or failed.
Prerequisites
You must submit an import, export, or reconfiguration task to view it in the task list.
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Procedure
1

Start vSphere Client and connect to the vCenter Server associated with vCenter Converter.

2

Click Inventory in the navigation bar and select the Hosts & Clusters view.

3

Select an inventory object (for example, a host) and click the Tasks & Events tab.

4

Click Tasks.

The task status is indicated by one of the following icons:
Task completed successfully.
Task failed. Review the task details for more information.
Task is queued or in progress. Tasks are queued when system resources are
heavily loaded. Queued tasks run when adequate system resources become
available. Tasks that are in progress include a status bar that displays the
percent completed.
What to do next
If the task completed successfully, the virtual machine appears in the inventory list.

Monitor Scheduled Tasks for All Inventory Objects
You can check all inventory objects to determine which tasks are scheduled and when each task last ran.
Procedure
1

Start vSphere Client and connect to the vCenter Server associated with vCenter Converter.

2

Click Scheduled Tasks in the upper-right corner of the navigation bar to determine which tasks are
scheduled and when each task last ran.

A detailed list of all scheduled tasks appears.
What to do next
You can monitor the status of all tasks in the Scheduled Tasks list.

Display Completed or Current Tasks for All Inventory Objects
You can monitor recently completed or current tasks for all inventory objects.
Procedure
1

Start vSphere Client and connect to the vCenter Server associated with vCenter Converter.

2

If the Recent Tasks panel is not displayed, click Tasks in the status bar.

The Recent Tasks panel displays information about recently completed or current tasks for all inventory objects.
What to do next
You can check the task details and monitor the status of the tasks.
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Display Task Details
You can display detailed information about specific tasks in the Task Details pane or the Task Summary dialog
box.
The Task Details pane displays information about the task and related events. When a task fails, this pane
includes information about the location of log files that might help troubleshoot the issue. Log files are
temporary, so access them as soon as possible after a failure.
Select one of the following methods to display details for a task.
Procedure
n

Select a task in the Tasks & Events task list.

n

Right-click a task in the Recent Tasks panel and select View Summary.

Details of the task appear in the Task Details pane.
What to do next
When the task completes, you can power on the virtual machine.

Copy a Task
You can create a new task by copying any task that is not queued or in progress or by copying scheduled tasks.
Copying tasks allows you to reuse and modify information from the original task without having to reenter it
into the wizard.
Procedure
u

In the Tasks & Events list, right-click a task and select Copy As New.

The wizard associated with the original task starts (for example, if the original task is an export task, the Export
wizard starts) so that you can modify the task settings to create a new task.
What to do next
Continue monitoring the status of the task. When the task has successfully completed, the object appears in
the host machine’s inventory list. You can check the state of the new or reconfigured inventory object on the
Summary tab.

Edit a Scheduled Task Immediately
You can edit a scheduled task to modify its settings before it runs.
Procedure
1

Click Scheduled Tasks in the navigation bar.

2

Right-click a task and select Properties.

The wizard associated with the original task starts (for example, if the original task is an export task, the Export
wizard starts) so that you can modify the task settings.
What to do next
Continue monitoring the status of the task. When the task has successfully completed, the object appears in
the host machine's inventory list. You can check the state of the new or reconfigured inventory object on the
Summary tab.
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Run a Scheduled Task Immediately
Scheduled tasks are designed to run at a specified date and time. However, you can choose to run a scheduled
task immediately. Running a scheduled task immediately does not affect the original schedule you specified.
Procedure
1

Click Scheduled Tasks in the navigation bar.

2

Right-click a task and select Run.

The task is run immediately, or queued until resources are available to run it. The task will run again at the
time it was originally scheduled for.
What to do next
Continue monitoring the status of the task. When the task has successfully completed, the object appears in
the host machine’s inventory list. You can check the state of the new or reconfigured inventory object on the
Summary tab.

Cancel a Task
You can cancel a task that is in the queue or in progress. Canceled tasks are labeled as failed, with a message
indicating that a user canceled the task.
Procedure
1

On the Tasks & Events tab, right-click the task and select Cancel.

2

Click Yes in the confirmation dialog box to cancel the task.

The task is canceled, labeled as failed, and removed from the list.
What to do next
You can create or start a new task or continue monitoring existing tasks.

Remove a Task
You can remove tasks from the scheduled tasks list at any time.
Procedure
1

Click Scheduled Tasks in the navigation bar.

2

Right-click a task and select Remove.

The task is removed from the scheduled tasks list.
What to do next
You can start a new task or continue monitoring existing tasks.
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8

Cold cloning, also called offline cloning, involves cloning the source machine when it is not running its
operating system. When you cold clone a machine, you reboot the source machine from a CD that has its own
operating system and also includes the vCenter Converter application.
This chapter includes the following topics:
n

“Create the vCenter Converter Boot CD,” on page 65

n

“Configure the Network,” on page 66

n

“Start the Import Wizard,” on page 66

n

“Select the Source Data,” on page 67

n

“Selecting a Destination for the New Virtual Machine,” on page 67

n

“Customize the Guest Operating System of the New Virtual Machine,” on page 69

n

“Use peTool to Modify the vCenter Converter Boot CD,” on page 73

Create the vCenter Converter Boot CD
Before you can use the vCenter Converter Boot CD, you must download the ISO file and create the CD.
Before the vCenter Converter application starts, you can modify the network settings of the operating system
on the CD. For example, you can provide a static IP address or change the DNS/WINS server address. This
procedure is optional. You can also modify these settings after you start the vCenter Converter application.
Procedure
1

Go to the VMware Web page and click the Downloads link.

2

On the Product Downloads page, click the VMware vSphere 4 Download link, then click the
VMware vCenter Server 4.0 Download link.

3

Enter your login credentials.
On the End-User License Agreement page, read the agreement, then select I accept the terms in the License
Agreement and click OK.

4

Click ZIP image next to the entry for VMware vCenter Converter Boot CD for vCenter Server to download
the file.
The file name is VMware-convertercd 4.1.0--<xxxxx>.zip, where <xxxxx> indicates the build number.

5

Extract the coldclone.iso file and use the software of your choice to create the vCenter Converter Boot CD
from the image file.

6

Insert the vCenter Converter Boot CD in the source machine and restart the computer.
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7

Within 10 seconds of restarting, press F12 to access the boot device menu.

8

Select the CD drive that contains the boot CD and press any key to continue.

9

(Optional) In the Network Configuration dialog box, change the location for the temporary files, including
the log files.
By default, temporary files are stored in RAM.

10

(Optional) Click Advanced and set a value for the Speed & Duplex property of each network adapter.

The vCenter Converter application starts.
What to do next
You can now start the import process.

Configure the Network
Before the vCenter Converter application starts, you can modify the network settings of the operating system
on the boot CD so the vCenter Converter components can communicate with the target virtual machine. For
example, you can provide a static IP address and change the DNS or WINS server address.
Prerequisites
This procedure is optional. You can also change these settings later in the vCenter Converter application.
Procedure
1

(Optional) Modify the network settings in the Network Configuration dialog box.
a

When prompted, Click Yes to update the settings. If you click No, the vCenter Converter Application
starts.

b

Select Administration > Network Configuration on the main vCenter Converter Application.

The Network Configuration dialog box opens.
2

Click the Network Properties tab.

3

Enter the static IP address and click Apply.

4

Click the Network Drives tab and map the drives to the network share.

5

Click Connect.

6

If necessary, enter the domain, user name, and password to connect to a specific network share and click
OK.

7

Click OK.

The network is now configured for its current environment.
What to do next
You can use the vCenter Converter Application to begin the conversion process.

Start the Import Wizard
You use the vCenter Converter Import wizard to select the source volumes and the destination for the virtual
machine, and to customize the virtual machine.
You can monitor and manage the import task in the vSphere Client, like any other task.
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Procedure
1

On the vCenter Converter application main menu, click Import Machine.

2

Click Next.

The Import wizard opens. Complete the wizard to add the conversion task to the task list.
What to do next
You are now ready to start the import process

Select the Source Data
To ease storage management, you can select which of the source machine volumes to import and specify their
size in the new virtual machine. You can also import all disks unchanged.
Procedure
1

On the Source page, click Next.

2

Change or maintain the imported disks.
a

To import all disks unchanged, check that Import all disks and maintain size is selected and click
Next.
This is the only choice if the virtual machine you are importing has a Linux guest operating system.

b

To resize the converted disks, click Select volumes and resize to save or add space.

3

Select any volumes that you do not want to import.

4

Specify the volume size for each volume in the New Disk Space drop-down menus and click Next.
Option

Description

Maintain Size

Keeps the original size volume.

Min Size

Converts just the used portion from the volume, with a small amount of space
added.

<Type Size in GB>

Enter a specific size in gigabytes

<Type Size in MB>

Enter a specific size in megabytes.

What to do next
You can now select a destination for the new virtual machine.

Selecting a Destination for the New Virtual Machine
You must select a destination for the virtual machine you are importing. You can select an ESX/ESXi virtual
machine destination, an ESX/ESXi host that vCenter Server 4.0 or VirtualCenter 2.x manages, or a standalone
virtual machine or backup image destination.

Select a vCenter Server Virtual Machine Destination
To import the virtual machine to run in an ESX/ESXi host that vCenter Server manages, you must first set the
configuration parameters.
Procedure
1

On the Destination page, click Next.

2

Select VMware vSphere Virtual Machine from the drop-down menu and click Next.
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3

Select the destination server in the drop-down menu or type the name of the server if it is not listed.

4

Type the administrator user name and password for the destination server and click Next.

5

Name the virtual machine, select a destination folder within the vCenter Server inventory, and click Next

6

Select a host, cluster, or resource pool from which to run the virtual machine.
a

On the Host or Cluster page, select the host, cluster, or resource pool and click Next.

b

On the Host page, select a host and click Next.

c

On the Resource Pool page, select a resource pool and click Next.

7

(Optional) If you select a cluster in manual mode, on the Host page select the host for the virtual machine.

8

(Optional) Distribute disks over several datastores or place the virtual machine configuration file and each
disk on a separate datastore and click Next.

9

a

Click Advanced to see the list of disks and the virtual machine configuration file.

b

Select a datastore for each disk and file from the drop-down menus.

On the Networks page, map the virtual machine network adapters to a network and click Next.
The Networks panel has drop-down menus that contain the networks available at the destination location.
You can set the number of adapters to map in a drop-down menu and you can choose whether to connect
the networks when the virtual machine is powered on.

What to do next
On the Customization page, you can select configuration options for the guest operating system.

Select an ESX/ESXi Virtual Machine Destination
To import the virtual machine to run on an unmanaged instance of an ESX/ESXi host, you must first set the
configuration parameters.
Depending on your source, you can select one or more datastores for the virtual machine configuration files
and disks.
Procedure
1

On the Destination page, click Next.

2

Select VMware vSphere Virtual Machine from the drop-down menu and click Next.

3

Select the destination server in the drop-down menu or type the name of the server if it is not listed.

4

Type the administrator user name and password for the destination server and click Next.

5

Enter a unique name to assign to the virtual machine and click Next.

6

Select the host for the virtual machine and click Next.

7

Select a datastore for the virtual machine configuration files and disks and click Next.
All datastores and their available space appear. You must select a datastore large enough to contain the
selected disks.

8

(Optional) To distribute disks over several datastores or to place the virtual machine configuration files
and each disk on a separate datastore, click Advanced.
Select the datastore for each disk and file from the drop-down menus.

9

Map the network adapters to networks on the destination ESX/ESXi host network and click Next.
The Networks panel has drop-down menus that contain the networks available at the destination location.
You can set the number of adapters to map in a drop-down menu as well.
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What to do next
On the Customization page, you can select configuration options for the guest operating system.

Select a Standalone Virtual Machine or Backup Image Destination
To import a virtual machine to run as a Workstation virtual machine, you must first set the configuration
parameters.
The Allocate all disk space now for better performance option creates a disk file that can be larger than the
used space of the source. For example, the source disk might be a 16GB disk of which only 2GB is used for the
file, but importing the file with the Allocate option creates a 16GB disk. Before you import, take this increase
in size into account when you examine free space.
Procedure
1

On the Destination page, click Next.

2

From the drop-down menu, select Other Virtual Machine and click Next.

3

Type a name for the converted virtual machine and browse to enter the destination location.

4

Select a type of virtual machine to create and click Next.

5

Select the import options for a full clone.
Depending on the type of source and destination, you might have the following options for how you
allocate disk space for the new virtual machine:
n

To allocate all of the disk space for this clone, select Allocate all disk space now for better
performance. This option gives somewhat better performance for your virtual machine.

n

If you select Allow virtual disk files to expand, the virtual disk’s files start small and increase as
needed, until they reach the size of the source disks from which they were cloned.

n

To support virtual disks on FAT file systems, ensure that the Split disk into 2 GB files check box is
selected.

6

Click Next.

7

Assign a unique name to the virtual machine.
The name can be 80 characters long and is case sensitive. It can contain alphanumeric characters and the
underscore (_) and hyphen (-).

8

Browse to or type the path of the location where you want to create the virtual machine and click Next.

9

Map the virtual machine network adapters to a bridged, host-only, or NAT network and click Next.

What to do next
On the Customization page, you can select configuration options for the guest operating system.

Customize the Guest Operating System of the New Virtual Machine
After you create and configure a virtual machine, you can customize the identity and network settings of the
virtual machine's guest operating system so that it is ready to begin work immediately in the target
environment.
The customization process varies depending on the guest operating system to be used in the new virtual
machine. You can install VMware Tools, customize a guest operating system, remove System Restore
checkpoints, or any combination of these options.
vCenter Converter does not support customization or VMware Tools installation for Windows NT guest
operating systems.
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To skip customization and run the task, see “Complete the Conversion Task,” on page 72.

Install VMware Tools
VMware Tools is a suite of utilities that enhances the performance of the virtual machine's guest operating
system and improves management of the virtual machine. For details about VMware Tools, see the vSphere
Basic System Administration guide.
Install VMware Tools on the target virtual machine.
Procedure
u

On the Customization page, ensure that Install VMware Tools is selected.

What to do next
You can continue setting the configuration options or click Next to schedule the task.

Customize the Identity of the New Virtual Machine
You can enter a name for the virtual machine, change the time zone, and modify the network properties.
If the Customize option is unavailable, you must install the Microsoft Sysprep tools on your vCenter Server
machine in the appropriate location. For example, C:\Documents and Settings\All Users\Application Data
\VMware\VMware VCENTER\sysprep.
You can customize the following information:
n

Change the computer information for identifying a virtual machine on a network.

n

Enter server license information.

n

Change the time zone for a virtual machine.

n

Modify the properties for each network interface.

Procedure
1

On the Customization page, select Customize the identity of the virtual machine and click Next.

2

On the Computer Information page, customize any of the following fields.
Option

Description

Computer Name

A unique name to identify the virtual machine on the network. Valid
characters include A-Z, a-z, 0-9, and the hyphen. The underscore (_) is
nonstandard, but vCenter Converter permits its use. The limit is 63
characters. The computer name cannot consist only of numerals.

Owner Name

Valid characters include all printable characters. The limit is 63 characters.

Organization

Valid characters include all printable characters. The limit is 63 characters.

Generate New Security ID (SID)

Generates a new security identifier. By default, the security ID is preselected
for Windows Vista systems.

3

Click Next.

4

Enter the Windows licensing information for this virtual machine, if necessary, and click Next.
You can leave the Product ID field blank and move to the next page.
The Include Server License Information check box only applies to Microsoft Windows 2000 Server and
Microsoft Windows Server 2003 operating systems. The Server License Mode buttons are disabled if the
check box is not selected. This action does not apply to Windows Vista.
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5

Select a time zone from the drop-down menu and click Next.
If network interfaces need to be set, the Network Interface Settings page appears.

6

7

(Optional) To customize your network adapter settings, select the adapter on the Network Interface
Settings page and click Customize.
n

The Reset All button is enabled if one or more network adapters were modified. Click Reset All to
return all settings for all adapters to the default and click Next.

n

By default, every network adapter obtains the IP address and DNS server address from the Dynamic
Host Configuration Protocol (DHCP). If you prefer to use the default settings, click Next.

(Optional) In the Network Properties dialog box, modify the properties of any network adapters.
Field

Description

General

Use this field only to manually enter the IP address and DNS server address.

DNS

Specify the DNS connections by entering DNS suffixes.
n For each DNS suffix you enter, click Add.
n If you are entering multiple DNS suffixes, use Move Up and Move Down
to change the order in which a virtual machine is to use the connections.

WINS

Specify the primary and secondary WINS addresses by typing the IP
addresses in the entry boxes.

8

Click OK to return to the Network Interface Settings page and click Next.

9

On the Workgroup or Domain page, select how the virtual machine participates in a network.

10

Field

Description

Workgroup

Valid characters include A-Z, a-z, 0-9, space, and the hyphen (-). Maximum
length is 15 characters.

Windows Server Domain

The text box must have a value. Valid characters include A-Z, a-z, 0-9, space,
period, and the hyphen (-). Each label delineated by a period can be 63
characters. The entire text string can be up to 254 characters. A user name
and password are required.

Click Next.

vCenter Converter configures the guest operating system of the new virtual machine according to your settings.
What to do next
After you complete the options on the Customization page, you can set the parameters for the conversion or
reconfiguration task.

Remove System Restore Checkpoints
Removing all System Restore checkpoints prevents the target machine from reverting to a preconversion state.
When you want the target virtual machine to be a replica of the source system, do not remove the System
Restore checkpoints. Otherwise, regardless of the cloning mode, remove all System Restore checkpoints.
CAUTION If you restore a checkpoint in the target virtual machine that was created before you cloned the source
machine, you can damage the system and cause the target virtual machine to become unbootable.
For more information about cloning modes, see “Cloning Modes,” on page 15.

VMware, Inc.

71

vCenter Converter Administration Guide

When you remove System Restore checkpoints, be aware of the following situations:
n

System Restore is enabled on Windows Vista, Windows XP, and Windows Server 2008 systems by default.

n

By default, System Restore is not installed on Windows Server 2003. If it is installed, a System Restore tab
is available in the System Properties dialog box of the Windows machine.

n

For any cloning mode of Windows XP sources, the Remove all system restore checkpoints option is
selected by default.

n

For volume-based, file-level cloning of Windows Vista and Windows Server 2008 sources, by default
vCenter Converter does not copy System Restore checkpoints to the target virtual machine. The Remove
all system restore checkpoints option is ignored.

Procedure
u

On the Customization page, select Remove all system restore checkpoints.

vCenter Converter does not copy the system restore checkpoints from the source to the destination virtual
machine.
What to do next
You can continue setting configuration options or click Next to schedule a conversion or reconfiguration task.

Complete the Conversion Task
After you review your selections on the Ready to Complete page of the wizard, you can start the conversion
task or go back and change a setting. You can also power on the machine after you create a virtual machine
for an ESX/ESXi host destination.
With the vCenter Converter Boot CD, you can import only one machine at a time.
Procedure
1

Review the summary of the settings for the new virtual machine.

2

If Windows discovers new hardware and asks you to reboot, choose No so that customization settings are
applied.
If you customized the new virtual machine, after it is powered on, you must wait for it to reboot twice
before the customization settings are applied and you can safely log in. Customization settings are not
applied to your virtual machine if you manually restart it.

3

Click Finish.

4

When the task is complete, select File > Exit to reboot the source computer.

The import task starts immediately. You can view the progress in the Task Progress tab.
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Use peTool to Modify the vCenter Converter Boot CD
You can download and use the VMware peTool to add Windows drivers to the boot CD ISO image. Using
peTool, you can add storage and network device drivers.
Procedure
1

Download VMware-convertercd-4.1.0-<xxxxx>.zip (where <xxxxx> indicates the build number) from the
vCenter Server 4.0 page that you access from the VMware vSphere Download page on the VMware Web
site.

2

Extract peTool.exe from the zip file.

3

Add the required network driver to the ISO image.
peTool -I <Conv_boot_cd.iso> -n <driver_folder_path>

You are now ready to configure and run the network software.
What to do next
Add the required drivers for storage and perform other actions using the peTool options. See “peTool Options,”
on page 73.

peTool Options
You can use the peTool Options to add runnable binary files and VNC packages and perform other actions.
Table 8-1. peTool Options
Option

Action

-h [--help]

Displays help messages.

-i [--image]

Selects the image file.
Selects the WinPE CD image to be modified. For example: -i c:
\coldclone.iso. The original of the ISO image is saved with a .bak
extension. In this example, it is saved as coldclone.iso.bak.

-f [--disable_firewall]

Disables the firewall.
Disables the firewall after the WinPE boot phase.

-d [--storage_driver]

Adds storage device drivers.
Must be followed by one or more full directory paths that contain the target
device drivers. The original VMware vCenter Converter Boot CD ISO image
does not contain these drivers. Use this option to select the drivers from
drivers you already have.

-n [--network_driver]

Adds network device drivers.
Must be followed by one or more full directory paths that contain the target
device drivers.

-t [--tmp]

Specifies the temporary directory for peTool. If the directory does not exist,
peTool creates it. If a temporary directory is not specified, peTool uses the
default temp file indicated by Windows.
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9

You can migrate physical and virtual source machines by using the converter-tool executable file and the
command-line interface (CLI).
The vCenter Converter CLI provides access to vCenter Converter functionality without requiring the
vSphere Client plug-in. You start the CLI by starting converter-tool.exe from a command prompt. You can
then submit import, export, and reconfigure jobs to a vCenter Server that has an associated vCenter Converter
server. Jobs are described in XML files based on the p2v.xsd XML schema.
This chapter includes the following topics:
n

“vCenter Converter CLI System Requirements,” on page 75

n

“Install and Run the vCenter Converter CLI on a Windows Computer,” on page 76

n

“Install and Run the vCenter Converter CLI on a Linux Computer,” on page 76

n

“converter-tool Syntax and Options,” on page 77

n

“Source and Destination Machines,” on page 80

n

“Restoring VMware Consolidated Backup Images,” on page 80

n

“Example XML Files for Importing,” on page 81

n

“Example XML Input File for Exporting,” on page 83

n

“Example XML Input File for Reconfiguration,” on page 84

n

“Example XML Output File for the --jI [--jobSourceInspect] Option,” on page 85

vCenter Converter CLI System Requirements
The vCenter Converter CLI can run on Windows and Linux computers.

Windows System Requirements
The vCenter Converter CLI supports several Windows operating systems and requires 36MB of RAM.
You can install the vCenter Converter CLI on the following Microsoft Windows operating systems:
n

Windows 2000

n

Windows Server (32 bit and 64 bit)

n

Windows XP Professional (32 bit and 64 bit)

n

Windows Vista (32 bit and 64 bit)

n

Windows Server 2008 (32 bit and 64 bit)
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Linux System Requirements
You can install the vCenter Converter CLI on Linux operating systems. The vCenter Converter CLI files require
195MB of RAM.
You can install the vCenter Converter CLI on the following Linux operating systems:
n

SUSE Linux Server 10

n

Red Hat Linux 5.0

Install and Run the vCenter Converter CLI on a Windows Computer
By default, the vCenter Converter CLI is available when you install the vCenter Converter server, either by
using the vCenter Converter installer or the VMware vCenter Server Installer.
The vCenter Converter CLI is installed in the same location as the vCenter Converter server. You can also use
the vCenter Converter installer to install the CLI on other computers. See “Install vCenter Converter,” on
page 29.
By default, the converter-tool.exe file is installed in the following location: C:\Program Files\VMware
\Infrastructure\Converter Enterprise.
Sample XML files, based on p2v.xsd, are installed in this location:C:\Program Files\VMware\Infrastructure
\Converter Enterprise\Documentation

Procedure
u

To run converter-tool, open a command prompt, navigate to the file location, type converter-tool.exe,
and press Enter.

Version information and the Help page for converter-tool is returned.
What to do next
You can now use converter-tool with its options to migrate physical or virtual machines. See Table 9-1.

Install and Run the vCenter Converter CLI on a Linux Computer
The vCenter Converter installer does not support Linux. Therefore, you must download the latest version of
the Linux installer.
Prerequisites
To use the CLI, you must be familiar with the converter-tool options. For a list and syntax of options see
Table 9-1.
Procedure
1

Download the latest version of the Linux installer from the vCenter Server 4.0 Web page, which is
accessible from the VMware vSphere 4 Download page on the VMware Web site.

2

Extract the contents of VMware-converter-4.1.0-<xxxxx>.tar.gz to a location of your choice.
In this example, <xxxxx> is the build number.

3

To run the converter-tool utility, open a terminal window and type converter-tool.sh, followed by the
options required for your task.

Version information and the Help page for converter-tool is returned.
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What to do next
You can now use converter-tool with its options to migrate physical or virtual machines.

converter-tool Syntax and Options
You can use the converter-tool utility to perform migrations by using either a short or long command format.
For example, to import machines described in the jobDescription.xml XML file, type one of the following
commands:
n

Short format: converter-tool --v. <vcserver> --vC <username:password> --jS <jobDescription.xml>

n

Long format: converter-tool --vcHost <vcserver> --vcCreds <username:password> --jobSubmit
<jobDescription.xml>

You can use only one action option with each command or command line, as follows:
n

--query

n

--verify

n

--import

n

--postprocess

In addition, you can use only one of the --job* options with each command or command line. If no options
are specified, converter-tool runs as if you specified --help.
Up to ten instances of converter-tool can run simultaneously.
You can perform the actions listed in Table 9-1.
Table 9-1. converter-tool Options
Option

Action

-? [--help]

Lists the options for the CLI.

--vH, --vcHost
[http://]hostname[.dns.domain.com][:port]

Specifies a vCenter Server host.
Specifies connection options for a vCenter Server system
with an associated vCenter Converter server.

--vC, --vcCreds Username[:Password]

Specifies the credentials necessary to log in to the vCenter
Server system specified with the --vcHost parameter. If this
option is not specified or the optional password is not
specified, you are prompted to provide the missing
information.
When the vCenter Server system specified with --vH or -vcHost also appears in the jobDescription.xml file, the
credentials specified with this option override the credentials
in the XML file.

--oF, --ovrOutputFile output.xml

Directs output to the specified file, XML except in the case of
the --jobSubmit option.

--oS, --ovrSourceCreds Username[:Password]

Specifies the credentials for the import or postprocessing
source. The credentials specified override the credentials in
the jobDescription.xml file.
This option is valid only when used in conjunction with -jobSubmit, --jobExec, --jobSourceInspect, or -jobValidate.

--oT, --ovrTargetCreds Username[:Password]

Specifies the credentials for the import target. The credentials
specified override the credentials specified in the
jobDescription.xml file.
This option is valid only when used in conjunction with the
--jobSubmit or --jobExec options.
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Table 9-1. converter-tool Options (Continued)
Option

Action

--oD, --ovrDomainAdminCreds Username[:Password]

Specifies the credentials of a Windows domain administrator
when customizing the target machine after the import is
complete. The credentials specified override the credentials
specified in the jobDescription.xml file.
This option is valid only when used in conjunction with -jobSubmit or --jobExec.

--jS, --jobSubmit jobDesciption.xml

Submits a job to the vCenter Converter Server to run
asynchronously and immediately returns a jobId to the
console. The input format for the jobDescription.xml file
is specified in the p2v.xsd file. A return value other than 0
indicates a failure to connect, a failure to submit the job, or
that the job description XML file is invalid.
If the jobDescription.xml file contains invalid XML code,
the invalid portion is identified in an error message.

--jE, --jobExec jobDescription.xml

Runs the specified job synchronously and returns a
continuous stream of output to the console that reflects the
progress of the job. When the job is complete, the output
described in the P2vOutput.xsd file is output followed by
the output described in the P2VStatus.xsd file or an
appropriate error message.
The input format for thejobDescription.xml file is
specified in the p2v.xsd file.
A return value other than 0 indicates a failure to connect, a
failure to start the job, or that the job description XML file is
invalid.
If the jobDescription.xml file contains invalid XML code,
the invalid portion is identified in an error message.

--jI, --jobSourceInspect jobDescription.xml

Returns detailed information about the source machine
specified in the XML file.
The input format is described in the p2v.xsd file.
The XML output format is specified in the
p2vOutput.xsdfile.

--jV, --jobValidate jobDescription.xml

Performs validation checks on the specified job description
file. Messages regarding any problems that are found are
output to the console.
The input format for the jobDescription.xml file is
specified in the p2v.xsd file.
A return value other than 0 indicates a failure to connect to
vCenter Server or the vCenter Converter server. Any errors
that are found in the jobDescription.xml file, including
any failures to connect to the machines specified in the XML,
return appropriate messages to the console and a return
value of 0.

--jC, --jobCancel jobId

Stops running the current job and removes it from the queue.
Information about the job is maintained and can be retrieved
by using the --jobQuery option.
Returns the Job canceled string or an appropriate error
message to the console.
A return value other than 0 indicates a failure to connect, or
that the jobId is invalid, already canceled, or cannot be
canceled.
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Table 9-1. converter-tool Options (Continued)
Option

Action

--jQ, --jobQuery jobId

Query the status of a submitted job.
Returns all import parameters for the specified job, with the
exception of passwords as specified in the P2vOutput.xsd
file (which includes P2VInput.xsd), followed by the
running status specified in P2VStatus.xsd.
A return value other than 0 indicates a failure to connect or
that the JobId is invalid.

--jW, --jobWait jobId

Waits until the submitted job is complete, fails, or is canceled
before returning a value. If the converter-tool utility is
interrupted while waiting for a job, only the --jobWait
option is interrupted. The anticipated jobId operation is not
interrupted.
Returns nothing to the console other than any appropriate
error messages.
A return value other than 0 indicates a failure to
communicate with the vCenter Converter server or an
invalid jobId.

--jG, --jobGetAll [jobState]

Returns a list of all jobs that this user starts.
Optionally, a jobStatemight be specified. In this case, only
jobs with the specified state are returned. The
jobStatespecified must be Queued,Running, Canceled,
Success, or Failed. The output format is specified in the
P2VJobList.xsd file.
A return value other than 0 indicates a failure to
communicate with the vCenter Converter server or an
invalid jobState parameter

NOTE If you do not provide the user name or password for accessing a source or destination in the
jobDescription.xml file, converter-tool prompts for the name or password.
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Source and Destination Machines
The converter-tool CLI supports the same sources and destinations as vCenter Converter 4.0 or VirtualCenter
2.x. You can perform several types of migrations, including live migrations of running physical or virtual
machines.
Running machine
requirements (can only
be a source)

Hosted machine
considerations (can be a
source or a destination)

Managed machine
considerations (can be a
source or a destination)

n

Can be a physical machine or a virtual machine accessible to the vCenter
Converter CLI.

n

Performs an import that avoids having to shut down the source machine.

n

Must be powered on at the time of import.

n

A flat-file virtual machine, typically from a Workstation product or a
supported backup format.

n

Must be on a network share that is accessible from the vCenter Converter
server.

n

If used as a source, the virtual machine must be powered off at the time it
is imported.

n

Virtual machines running on an instance of ESX/ESXi.

n

The server can be specified as an ESX/ESXi host or an ESX/ESXi host that
vCenter Server manages.

n

If used as a source, the virtual machine must be powered off at the time of
the import.

In all cases, either the source, the destination, or both, must be managed by vCenter Server with an associated
vCenter Converter server.
Not all vCenter Converter CLI tasks support all types of sources and destinations. Table 9-2 displays the
supported tasks for each source and destination type.
Table 9-2. Supported Source and Destination Types for vCenter Converter CLI Tasks
Importing

Exporting

Reconfiguring

Sources

Live, hosted, managed

Managed only

Managed only

Destinations

Managed only

Managed, hosted

NA

Restoring VMware Consolidated Backup Images
VCB enables you to back up entire ESX/ESXi virtual machines, and store the backup using Workstation disks,
a .vmx file, and a catalog file. The converter-tool utility can restore VCB images into ESX/ESXi hosts that
vCenter Server manages.
The converter-tool utility does not preserve certain virtual machine properties, unless settings for the attributes
that can preserve the properties are included in the input XML file. Table 9-3 shows the attribute settings that
preserve these properties.
Information in the catalog file is not extracted. To restore to the same location, look at the original catalog file
and include that information in the input XML file.
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Table 9-3. Settings to Preserve Properties
Node

Attribute

Settings

ImportParams

keepIdentity

Default is false. Set to true to preserve the virtual machine identity.

preserveDeviceBackingInfo

Default is false. Set to true to preserve the device backing
information for CD-ROM, floppy, serial port, and parallel port.

preserveNicsInfo

Default is false. Set to true to use the network adapter information
from the source.

NicMappings

Example XML Files for Importing
When you install the vCenter Converter CLI, it includes sample job description XML files that you can modify
for your own import jobs.
Example 9-1. Importing a Live Local Machine to a Managed Destination
<?xml version="1.0" encoding="UTF-8" ?>
<p2v version="1.0" xmlns="http://www.vmware.com/v2/sysimage/p2v" xmlns:xsi="http://www.w3.org/
2001/XMLSchema-instance" xsi:schemaLocation="http://www.vmware.com/v2/sysimage/p2v p2v.xsd"
uninstallAgentOnSuccess="0">
<source>
<liveSpec>
<creds host="source-machine" username="Administrator" password="password"/>
</liveSpec>
</source>
<dest>
<managedSpec vmName="destination-vm">
<!--The vCenter Server specified below must be the same one specified with the command
line parameter --vcHost. The vCenter Server must have an associated the vCenter Converter server.->
<creds host="destination-vc" username="Administrator" password="password"/>
</managedSpec>
</dest>
<importParams targetProductVersion="PRODUCT_MANAGED"/>
<!--The converter-tool --jI [--jobSourceInspect] option retrieves source information, and its
XML output contains the volume ID.--->
<volumesToClone>
<volumeCloneInfo separateDisk="false"
volumeId="{computer={4f81c5e3b1e98fbcac551f6dce8952769562e323},1}"/>
<volumeCloneInfo separateDisk="true"
volumeId="{computer={4f81c5e3b1e98fbcac551f6dce8952769562e323},2}"/>
<volumeCloneInfo separateDisk="true"
volumeId="{computer={4f81c5e3b1e98fbcac551f6dce8952769562e323},3}"/>
</volumesToClone>
<postProcessingParams>
<reconfigParams />
</postProcessingParams>
</p2v>

For example XML output for the converter-tool --j I option, see “Example XML Output File for the --jI [-jobSourceInspect] Option,” on page 85.
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Example 9-2. Importing a Managed Source to a Managed Destination
<?xml version="1.0" encoding="UTF-8" ?>
<p2v version="1.0" xmlns="http://www.vmware.com/v2/sysimage/p2v" xmlns:xsi="http://www.w3.org/
2001/XMLSchema-instance" xsi:schemaLocation="http://www.vmware.com/v2/sysimage/p2v p2v.xsd">
<source>
<managedSpec vmId="source-vm">
<!-- username and password may be omitted. If the vCenter Server specified here is the
same as the one specified from the command line, then the vCenter Converter server will use the
credentials specified from the command line. Otherwise, you will be interactively prompted for
credentials-->
<creds host="source-vc" username="Administrator" password="password"/>
</managedSpec>
</source>
<dest>
<managedSpec vmName="destination-vm">
<!-- username and password may be omitted. If the vCenter Server specified here is the
same as the one specified from the command line, then vCenter Converter server will use the
credentials specified from the command line. Otherwise, you will be interactively prompted for
credentials -->
<creds host="destination-vc" username="Administrator" password="password"/>
</managedSpec>
</dest>
<importParams targetProductVersion="PRODUCT_MANAGED"/>
<postProcessingParams>
<reconfigParams/>
</postProcessingParams>
</p2v>

Import a hosted source to a managed destination:
<?xml version="1.0" encoding="UTF-8" ?>
<p2v version="1.0" xmlns="http://www.vmware.com/v2/sysimage/p2v" xmlns:xsi="http://www.w3.org/
2001/XMLSchema-instance" xsi:schemaLocation="http://www.vmware.com/v2/sysimage/p2v p2v.xsd">
<source>
<!--The "password" attribute is only used for Symantec's SV2I format sources and can be
omitted for other types of sources. The networkUsername should be of the form "machine\username"
-->
<hostedSpec path="\\source-machine\My Virtual Machines\winXP\winXPPro.vmx" password=""
networkUsername="domain\username" networkPassword="password"/>
</source>
<dest>
<managedSpec vmName="destination-vm">
<!-- username and password may be omitted. If the vCenter Server specified here is the
same as the one specified from the command line, the vCenter Converter server uses the credentials
specified from the command line. Otherwise, you are interactively prompted for credentials -->
<creds host="destination-vc" username="Administrator" password="password"/>
</managedSpec>
</dest>
<importParams targetProductVersion="PRODUCT_MANAGED"/>
<postProcessingParams>
<reconfigParams/>
</postProcessingParams>
</p2v>
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Example XML Input File for Exporting
When you install the vCenter Converter CLI, it includes sample job description XML files that you can modify
for your own export jobs.
Example 9-3. Exporting a Managed Source to a Hosted Destination
<?xml version="1.0" encoding="UTF-8" ?>
<p2v version="1.0" xmlns="http://www.vmware.com/v2/sysimage/p2v" xmlns:xsi="http://www.w3.org/
2001/XMLSchema-instance" xsi:schemaLocation="http://www.vmware.com/v2/sysimage/p2v p2v.xsd">
<source>
<managedSpec vmId="source-vm">
<!-- username and password may be omitted. If the vCenter Server specified here is the
same as the one specified from the command line, the vCenter Converter server will use the
credentials specified from the command line. Otherwise, you will be interactively prompted for
credentials-->
<creds host="source-vc" username="Administrator" password="password"/>
</managedSpec>
</source>
<dest>
<!-- The networkUsername should be of the form "machine\username" -->
<hostedSpec vmName="destination-vm" path="\\destination-machine\My Virtual Machines"
networkUsername="dest-machine\Administrator" networkPassword="password"/>
</dest>
<importParams targetProductVersion="PRODUCT_WS_5X"/>
<postProcessingParams>
<reconfigParams/>
</postProcessingParams>
</p2v>

Exporting a managed source to a managed destination:
<?xml version="1.0" encoding="UTF-8" ?>
<p2v version="1.0" xmlns="http://www.vmware.com/v2/sysimage/p2v" xmlns:xsi="http://www.w3.org/
2001/XMLSchema-instance" xsi:schemaLocation="http://www.vmware.com/v2/sysimage/p2v p2v.xsd">
<source>
<managedSpec vmId="source-vm">
<!--username and password may be omitted. If the vCenter Server specified here is the
same as the one specified from the command line, the vCenter Converter server will use the
credentials specified from the command line. Otherwise, you will be interactively prompted for
credentials -->
<creds host="source-vc" username="Administrator" password="password"/>
</managedSpec>
</source>
<dest>
<managedSpec vmName="destination-vm">
<!--username and password may be omitted. If the vCenter Server specified here is the
same as the one specified from the command line, the vCenter Converter server will use the
credentials specified from the command line. Otherwise, you will be interactively prompted for
credentials -->
<creds host="destination-vc" username="Administrator" password="password"/>
</managedSpec>
</dest>
<importParams targetProductVersion="PRODUCT_MANAGED"/>
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<postProcessingParams>
<reconfigParams/>
</postProcessingParams>
</p2v>

Example XML Input File for Reconfiguration
When you install the vCenter Converter CLI, it includes a sample job description XML file that you can modify
for your own reconfigure jobs.
Example 9-4. Reconfiguring a Managed Source
<?xml version="1.0" encoding="UTF-8">
<p2v version="1.0" xmlns="http://www.vmware.com/v2/sysimage/p2v" xmlns:xsi="http://www.w3.org/
2001/XMLSchema-instance" xsi:schemaLocation="http://www.vmware.com/v2/sysimage/p2v p2v.xsd">
<source>
<managedSpec vmId="reconfig-target-vm">
<!-- username and password may be omitted. If the vCenter Server specified here is the
same as the one specified from the command line, the vCenter Converter server will use the
credentials specified from the command line. Otherwise, you will be interactively prompted for
credentials -->
<creds host="target-vc" username="Administrator" password="password"/>
</managedSpec>
</source>
<postProcessingParams>
<reconfigParams/>
</postProcessingParams>
</p2v>
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Example XML Output File for the --jI [--jobSourceInspect] Option
When you import a live source to a managed destination, an XML output file is created.
Example 9-5. XML Output for the converter-tool ---jI [--jobSourceInspect] Option
<p2v uninstallAgentOnSuccess="1" version="2.2" xmlns="http://www.vmware.com/v2/sysimage/p2v"
xmlns:xsi="http://www.w3.org/2001/XMLSchema-instance" xsi:schemaLocation="http://www.vmware.com/
v2/sysimage/p2v p2vOutput.xsd" xsi:type="P2VOutput">
<source>
<liveSpec>
<creds host="10.18.127.117" password="" port="0" username="Administrator"/>
</liveSpec>
</source>
<dest>
<managedSpec datastore="#datastore-1245" folder="#group-v3" host="#host-1242"
resourcePool="" vmName="ag-nt4-test-tool">
<creds host="10.17.166.43" port="0" type="sessionId" username="Administrator"/>
</managedSpec>
</dest>
<importParams diskType="VMFS" preserveHWInfo="true" removeSystemRestore="true"
targetProductVersion="PRODUCT_MANAGED"/>
<postProcessingParams removeSystemRestore="true">
<reconfigParams/>
</postProcessingParams>
<sourceInfo>
<osInfo displayName="Windows NT 4" edition="Server" guestOsId="winNTGuest" is64Bit="false"
majorVersion="4" minorVersion="0" osFamily="WINDOWS" spLevel="6" vendor="Microsoft"/>
<disks>
<diskInfo capacity="2106720256" deviceNumber="0"
id="disk={9ba2498e79b590fd75d62d8b65fa945c367c0fea}"/>
</disks>
<volumes>
<volumeInfo capacity="2099232768" diskDeviceNumber="0" drive="C:"
id="attVol={computer={4f81c5e3b1e98fbcac551f6dce8952769562e323},1}" isActiveVolume="true"
isFilesystemUnderstood="true" isSystemVolume="true" used="1847039488"/>
</volumes>
<nics>
<nicInfo network=""/>
</nics>
</sourceInfo>
<compatibilityReport>
<compatibility compatibilityWarning="IMPORT_OK_NO_CUSTOMIZE"/>
<compatibility compatibilityWarning="IMPORT_OK_NO_INSTALL_TOOLS"/>
</compatibilityReport>
</p2v>

VMware, Inc.

85

vCenter Converter Administration Guide

86

VMware, Inc.

Glossary

BIOS (basic input/output system)
Firmware that controls machine startup and manages communication between the CPU and other devices,
such as the keyboard, monitor, printers, and disk drives.
bridged networking
In hosted products, a type of network connection between a virtual machine and the host’s physical
network. With bridged networking, a virtual machine appears to be an additional computer on the same
physical Ethernet network as the host. See also custom networking, NAT (network address translation).
clone
(n.) A duplicate of a virtual machine. (v.) To make a copy of a virtual machine. Hosted products distinguish
between full clones and linked clones. See also full clone, linked clone.
cluster
A server group in the virtual environment. Clusters enable a high-availability solution.
cold cloning
In VMware vCenter Converter, cloning a local physical machine while it is running in WinPE from the
vCenter Converter Boot CD, not from its own operating system. See also hot cloning.
concurrent migrations
In VMware vCenter Converter, the Task Manager’s ability to direct the conversion and migration of
multiple virtual machines at the same time.
configuration
See virtual machine configuration.
custom networking
In hosted products, any type of network connection between virtual machines and the host that does not
use the default bridged, host-only, or network address translation (NAT) configurations. For example,
virtual machines can be connected to the host by separate networks or connected to each other and not to
the host. See also bridged networking, vCenter Converter Boot CD (VMware vCenter Converter Boot
CD), NAT (network address translation).
datacenter
A required structure under which hosts and their associated virtual machines are added to the vCenter
Server. vCenter Server supports multiple datacenters. A host can be managed under only one datacenter.
datacenter folder
An optional inventory grouping structure contained within the datacenter structure. A vCenter Server
supports multiple datacenter folders. Datacenter folders can contain only datacenters and other datacenter
folders.
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datastore
Virtual representations of combinations of underlying physical storage resources in the datacenter. A
datastore is the storage location (for example, a physical disk, a RAID, or a SAN) for virtual machine files.
destination virtual machine
In VMware vCenter Converter, the migrated virtual machine at its final location.
DHCP (Dynamic Host Configuration Protocol)
A communications protocol that enables dynamic addressing. The software relieves administrators of the
task of assigning an IP address to each device that connects to a network.
DNS (Domain Name System)
An Internet data query service that translates host names into IP addresses. Also called Domain Name
Server or Domain Name Service.
EULA (end user license agreement)
The software license that details any restrictions placed on users.
FAT (file allocation table)
See file allocation table (FAT).
file allocation table (FAT)
An area on a disk that stores information about the location of each piece of every file on the disk and
about the location of unusable areas of the disk.
FQDN (fully qualified domain name)
The name of a host that includes the host name and the domain name. For example, the FQDN of a host
named esx1 in the domain vmware.com is esx1.vmware.com.
full clone
A complete copy of the original virtual machine, including all associated virtual disks. See also linked
clone.
full virtual machine backup
Backs up all files that make up the entire virtual machine. These files include disk images, .vmx files, and
so on.
GOS (guest operating system)
See guest operating system.
growable disk
A type of virtual disk in which the disk space is not preallocated to its full size. The disk files begin small
and grow as data is written to the disk. See also preallocated disk.
guest operating system
An operating system that runs inside a virtual machine. See also host operating system.
guest user
An unauthenticated user who can log in to a system with a temporary user name and password. A guest
user has restricted access to files and folders and has a set of restricted permissions
host

A computer that uses virtualization software to run virtual machines. Also called the host machine or host
computer. The physical computer on which the virtualization (or other) software is installed.

host agent
Software that performs actions on behalf of a remote client when installed on a virtual machine host.
host computer
The physical computer on which VMware Player software is installed. The host computer hosts the ACE
instances.

88

VMware, Inc.

Glossary

hosted machine
The physical computer on which the VMware Workstation software is installed. The hosted machine hosts
the VMware Workstation virtual machines.
hosted products
VMware products (including Workstation, VMware Player, VMware Server, VMware ACE, and Lab
Manager) that run as applications on physical machines with operating systems such as Microsoft
Windows or Linux. See also hypervisor.
host operating system
An operating system that runs on the host machine. See also guest operating system.
hot cloning
In VMware vCenter Converter, cloning a local or remote physical machine while it is running in its own
operating system. See also cold cloning.
hypervisor
A platform that allows multiple operating systems to run on a host computer at the same time.
IDE

(1) Acronym for integrated drive electronics, a standard electronic interface used to connect mass storage
devices to a computer. The ANSI name for IDE is Advanced Technology Attachment (ATA). (2) Acronym
for integrated development environment.

incremental backup
A process that backs up only those files that have changed since the last backup, whether it is a full or
incremental backup.
inventory
A hierarchical structure used by the vCenter Server or the host agent to organize managed entities. This
hierarchy is a list of all the monitored objects in vCenter Server.
inventory mapping
Mapping between resource pools, networks, and virtual machine folders on the protection site and their
destination counterparts on the recovery site.
LAN segment
A private virtual network that is available only to virtual machines within the same team. See also virtual
network.
linked clone
A copy of the original virtual machine. The copy must have access to the parent virtual machine’s virtual
disks. The linked clone stores changes to the virtual disks in a separate set of files. See also full clone.
local cloning
The process of making a copy of a virtual machine residing in the system on which VMware vCenter
Converter is running, or making a copy of the physical machine itself for conversion to a virtual machine.
See also remote cloning.
LUN (logical unit number)
An identifier for a disk volume in a storage array.
managed entity
A managed object that is present in the inventory. See also inventory, managed object.
managed object
An object that resides on a server and is passed between the client and the Web service only by reference.
A managed object has operations associated with it but might not have properties.
migration
The process of moving a virtual machine between hosts. Unless VMotion is used, the virtual machine must
be powered off when you migrate it. See also migration with VMware vCenter Converter.
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migration with VMware vCenter Converter
The process of moving a powered off virtual machine from a local or remote host, while reconfiguring the
file format, if necessary, to accommodate the destination machine.
NAS (network-attached storage)
A complete storage system that is designed to be attached to a traditional data network.
NAT (network address translation)
In hosted networking, a type of network connection that enables you to connect your virtual machines to
an external network when you have only one IP network address and the host computer uses that address.
The VMware NAT device passes network data between one or more virtual machines and the external
network. It identifies incoming data packets intended for each virtual machine and sends them to the
correct destination. See also bridged networking, vCenter Converter Boot CD (VMware vCenter Converter
Boot CD), custom networking.
NIC (network interface card)
An expansion board that provides a dedicated connection between a computer and a network. Also called
a network adapter.
NTFS file system
The correct, redundant use of new technology file system.
NTP (Network Time Protocol)
A protocol for distributing the Coordinated Universal Time (UTC) by synchronizing the clocks of
computer systems over packet-switched, variable-latency data networks.
nvram (nonvolatile RAM)
The file name used for storing BIOS settings belonging to a virtual machine.
page file
A component of an operating system that provides virtual memory for the system. Recently used pages
of memory are swapped out to this area on the disk to make room in physical memory (RAM) for newer
memory pages. Also called a “swap file.” See also virtual memory.
permission
A data object consisting of an authorization role, a user or group name, and a managed entity reference.
A permission allows a specified user to access the entity (such as a virtual machine) with any of the
privileges pertaining to the role.
persistent mode
A disk mode in which all disk writes issued by software running inside a virtual machine are immediately
and permanently written to a virtual disk that is configured as an independent disk. As a result, a virtual
disk or physical disk in independent-persistent mode behaves like a conventional disk drive on a physical
computer.
physical CPU
A single physical CPU in a physical machine.
physical disk
In hosted products, a hard disk in a virtual machine that is mapped to a physical disk drive or partition
on the host machine. A virtual machine’s disk can be stored as a file on the host file system or on a local
hard disk. When a virtual machine is configured to use a physical disk, vCenter Server directly accesses
the local disk or partition as a raw device (not as a file on a file system). See also virtual disk.
port group
A construct for configuring virtual network options such as bandwidth limitations and VLAN tagging
policies for each member port. Virtual networks that are connected to the same port group, share network
policy configuration. See also virtual network, VLAN (virtual local area network).
power cycle
The process of disconnecting power from the computer and then adding power again. A power cycle
generally has the effect of restarting the system.
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PRD (product requirements document)
Produced by the Product Marketing group during the Investigation stage of the Request Evaluation phase.
preallocated disk
A type of virtual disk in which all disk space for the virtual machine is allocated at the time the disk is
created.
privilege
Authorization to perform a specific action or set of actions on a managed object or group of managed
objects.
provisioned storage
Maximum amount of storage the current entity can use.
provisioning
The process of creating a functioning virtual machine by assigning resources such as CPU, memory, and
virtual hardware and then deploying a system image.
read-only user
A role in which the user is allowed to view the inventory but not allowed to perform any tasks.
remote cloning
Making a copy of a virtual machine or a physical machine accessed over the network by VMware vCenter
Converter. See also local cloning.
resource pool
A division of computing resources used to manage allocations between virtual machines.
role

A defined set of privileges that can be assigned to users and groups to control access to VMware vSphere
objects.

root user
The superuser who has full administrative privileges to log in to an ESX/ESXi host. The root user can
manipulate permissions, create users and groups, and work with events.
SAN (storage area network)
A large-capacity network of storage devices that can be shared among multiple VMware ESX/ESXi hosts.
A SAN is required for VMotion.
scheduled task
A vCenter Server activity that is configured to occur at designated times. In VMware Converter, scheduled
tasks consist of migrations and configurations of virtual machines.
server
(1) A system capable of managing and running virtual machines. (2) A process capable of accepting and
executing instructions from another process.
snapshot
A reproduction of the virtual machine just as it was when you took the snapshot, including the state of
the data on all the virtual machine’s disks and the virtual machine’s power state (on, off, or suspended).
You can take a snapshot when a virtual machine is powered on, powered off, or suspended.
source
In VMware vCenter Converter, the machine from which you import or create a virtual machine.
source virtual machine
In VMware vCenter Converter, the virtual machine to be imported, at its original location.
standalone virtual machine
A virtual machine that runs in VMware Workstation, VMware Server, and VMware Player. See also source
virtual machine.
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supported partition
A virtual disk partition that VMware Tools can prepare for shrinking, such as one of the drives that make
up the virtual hard disk.
swap file
See page file.
swapping
When you power on a virtual machine, a process in which a corresponding swap file is created and placed
in the same location as the virtual machine configuration file (.vmx file). The virtual machine can power
on only when the page (swap) file is available. ESX/ESXi hosts use swapping to forcibly reclaim memory
from a virtual machine when no vmmemctl driver is available.
SYNC driver
A filter driver whose purpose is to quiesce an operating system's I/O subsystem to allow consistent
backups to be made.
target
The object that corresponds to a request URL.
task

A managed object representing the state of a long-running operation.

TCP (Transmission Control Protocol)
A reliable transfer protocol used between two endpoints on a network. TCP is built on top of the Internet
Protocol (IP). See also TCP/IP (Transmission Control Protocol/Internet Protocol).
TCP/IP (Transmission Control Protocol/Internet Protocol)
The set of protocols that is the language of the Internet, designed to enable communication between
networks regardless of the computing technologies that they use. TCP connects hosts and provides a
reliable exchange of data streams with guaranteed delivery. IP specifies the format of packets and handles
addressing. See also UDP (User Datagram Protocol).
UDP (User Datagram Protocol)
One of the core protocols in the Internet protocol suite. UDP enables a program to send packets (datagram)
to other programs on remote machines. UDP does not require a connection and does not guarantee reliable
communication. It is a quick and efficient method for broadcasting messages over a network. See also
TCP/IP (Transmission Control Protocol/Internet Protocol).
UUID (universally unique identifier)
A number used to uniquely identify some object or entity. The UUID is either assigned by VMware vSphere
(in the case of virtual machines) or is hardware-assigned (in the case of SCSI LUNs). vCenter Server
attempts to ensure that the UUIDs of all virtual machines being managed are unique, changing the UUIDs
of conflicting virtual machines if necessary.
valid cluster
A cluster that is not overcommitted or otherwise invalid.
VCB proxy (VMware Consolidated Backup proxy)
In VMware Consolidated Backup, VCB proxy is a physical or virtual machine running Microsoft Windows
2003, Consolidated Backup, and third-party backup software. VCB proxy is used to perform file-level and
image-level virtual machine backups.
VCS (Veritas Cluster Server)
Symantec clustering software for reducing application downtime. VCS runs on UNIX, Linux, Windows,
and VMware systems.

92

VMware, Inc.

Glossary

virtual appliance
A software solution that is composed of one or more virtual machines. A virtual appliance is packaged as
a unit by an appliance vendor and is deployed, managed, and maintained as a unit. Converting virtual
appliances allows you to add preconfigured virtual machines to your vCenter Server, ESX/ESXi server,
Workstation, or Player inventory.
vCenter Converter Boot CD (VMware vCenter Converter Boot CD)
The means by which a user can perform a local cold clone of a physical machine. When the physical
machine is booted from the vCenter Converter Boot CD, the Converter application runs on WinPE. It uses
a RAM disk for its operations and leaves no footprint on the physical machine.
virtual disk
A file or set of files that appears as a physical disk drive to a guest operating system. These files can be on
the host machine or on a remote file system. See also growable disk, physical disk, preallocated disk.
virtual hardware
The devices that make up a virtual machine. The virtual hardware includes the virtual disk, removable
devices such as the DVD-ROM/CD-ROM and floppy drives, and the virtual Ethernet adapter.
virtual machine
A virtual machine is a software computer that, like a physical computer, runs an operating system and
applications. Multiple virtual machines can operate on the same host system concurrently. See the
guidelines for using the acronym VM in place of virtual machine.
virtual machine administrator
A role in which the user can perform all the virtual machine management functions.
virtual machine array
A set of virtual machines that can be operated on collectively. Currently called a VM Group or VM Folder
in vCenter Server.
virtual machine communication interface (VMCI)
An infrastructure that provides communication between a virtual machine and the host operating system
and between two or more virtual machines on the same host. The VMCI SDK facilitates development of
applications that use the VMCI infrastructure.
virtual machine configuration
The specification of which virtual devices, such as disks and memory, are present in a virtual machine
and how they are mapped to host files and devices. In vCenter Converter, VMware virtual machines whose
disks have been populated by restoring from a backup or by some other direct means of copying undergo
configuration to enable them to boot in VMware products. See also virtual machine.
virtual machine configuration file
A file containing a virtual machine configuration. This .vmx file is created when you create the virtual
machine. It is used to identify and run a specific virtual machine.
virtual machine group
An optional grouping structure and a subset of a farm. vCenter Server supports multiple virtual machine
groups. Virtual machine groups contain virtual machines and other virtual machine groups.
Virtual Machine Properties control panel
In VMware vSphere Client, a point-and-click control panel used to view and modify the resource settings
of all the virtual machines on a host.
virtual machine settings editor
A point-and-click control panel used to view and modify the settings of a virtual machine setting.
virtual memory
An extension of a system’s physical memory, enabled by the declaration of a page file. See also page file.
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virtual network
A network connecting virtual machines that does not depend on physical hardware connections. For
example, you can create a virtual network between a virtual machine and a host that has no external
network connections. You can also create a LAN segment for communication between virtual machines
on a team. See also LAN segment.
virtual switch
A virtualized network switch used by ESX/ESXi server to manage traffic between virtual machines, the
service console, and the physical network adapters on the ESX/ESXi server machine.
VLAN (virtual local area network)
A software-managed logical segmentation of a physical LAN. Network traffic within each segment is
isolated from traffic in all other segments.
VM (acronym for virtual machine)
Restricted use. A virtual machine is a software computer that, like a physical computer, runs an operating
system and applications. A virtual machine is also referred to as a VM. Use the acronym VM when the
screen or controls do not have sufficient space to use the complete term virtual machine.
vNIC
A virtual network interface card that is configured on top of a system's physical Network adapter. See also
NIC (network interface card).
vSwitch
See virtual switch.
WAN (wide area network)
A computer network that connects a wider area than a local area network, typically by use of high-speed,
long-distance communications technology.
WINS (Windows Internet Naming Service)
Windows software that dynamically maps machine names to IP addresses.
XML (Extensible Markup Language)
A text-based markup language (a subset of SGML) designed for structured Web documents. XML enables
users to define their own tags that encode information with meaningful structure and semantics.
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TCP/IP and UDP port requirements 26
vCenter Converter CLI 75
System Restore Checkpoints, removing 45, 54,
60, 71

T
table of contents pane 49
task
completing export creation 56
completing import creation 47
completing import setup 72
completing reconfiguration setup 60
frequency 17
Task Details 63
tasks
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failed 61
in progress 61
managing 61
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queued 61
recurring 16
removing 64
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scheduling 46, 55
scheduling frequency 46, 56
scheduling to run immediately 46, 55
TCP/IP and UDP port requirements 26
thin-provisioned target disks 9
time zone, changing 43, 53, 58, 70

U
uninstalling, vCenter Converter client 33

V
VCB full backup images 25
VCB images
hardware information not preserved 16
virtual machine properties not preserved 16
vCenter Converter
agent 10
client 10
components 10
connection to vCenter Server 21
migration with 9
tasks 9
uninstalling components 31
vCenter Converter CLI
exporting with 83
importing with 81, 85
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reconfiguring with 84
running 76
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virtual disks, on FAT file systems 69
virtual hardware
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virtual machines
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keeping unlimited number of 16
supported for import 24
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Virtual PC images, requirements for
importing 25
VMware Consolidated Backup (VCB) 15, 80
VMware Fusion 24
VMware Tools, installing 43, 52, 58, 70
VMware vCenter Converter
default location of application folder 29
removing 31
repairing 31
VMware vCenter Converter Boot CD
creating 65
modifying network settings 65
VMware vCenter Converter Client
installing 32
removing 33
repairing 33
uninstalling 33
VMware Workstation 24
volume-based cloning 15
volume, supported types 15
volumes, creating a separate disk for 36
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Windows NT guest operating systems 57
Windows Server 2008 Hyper-V 24
Windows Server Domain 43, 53, 58, 70
Windows virtual machines, reconfiguring 57
Windows XP
checking Windows Firewall blocks 23
turning off Simple File Sharing 24
WINS, specifying the addresses 43, 53, 58, 70
wizard, export 49
wizard table of contents pane 49
Workstation
.vmx file 15
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Windows
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